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Introduction to RealPort
Digi’s patented RealPort software provides a virtual connection to serial 
devices, no matter where they reside on the network. The software is 
installed directly on the host and allows applications to talk to devices 
across a network as though the devices were directly attached to the host. 
In actuality, the devices are connected to a Digi device server or terminal 
server somewhere on the network. 
RealPort is unique among COM port re-directors because it is the only 
implementation that allows multiple connections to multiple ports over a 
single TCP/IP connection. Other implementations require a separate TCP/
IP connection for each serial port. Unique features also include full 
hardware and software flow control, as well as tunable latency and 
throughput.

Device Support
Digi's RealPort software works with the Digi CM, Digi One, PortServer II,  
PortServer TS, Digi Connect, DigiFlex, and EtherLite families. Encrypted 
RealPort software works with Digi One, PortServer TS, and the Digi 
Connect families. 

About This Guide

Purpose
Use this guide to install and configure RealPort on a variety of operating 
systems.

Audience
This guide is intended for the person responsible for installing and 
configuring RealPort. This person should have experience configuring 
network devices and be familiar with networking concepts.
Following are the conventions used in this document:

Conventions: Special Fonts
A typewriter font is used for any input you need to enter. Examples appear 
after descriptive text as in the the following text:  

set config

Conventions: Square Brackets
Optional parameters are displayed within square brackets.  

set config [dhcp=on]

Note: The square brackets themselves are not actually part of the command, and 

Chapter 1 I n t r o d u c t i o n
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should not be entered.

Conventions: Italics
Variables are displayed in italics.  

set config ip=ip-address

Note: Substitute an appropriate IP address for ip-address in the above command.

Conventions: Vertical Bar
A vertical bar character (|) is used to denote a choice (logical "or"). 

set flow=on|off

Note: The above command would be entered as either:
set flow=on or set flow=off
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RealPort Driver Requirements 
• 2 MB free hard disk memory 

• 400 KB memory per device

Limitations
Only TAPI-compliant applications or those written to COM 32 API 
(application programming interface) standards can use intelligent ports, 
which means only these applications can use RealPort ports.

Key Concept: About Port Mapping Offsets
The number of local ports on the Windows Server 2003/2000/XP host 
offsets the port number on the Digi device. For example, if you have two 
local COM ports, Port 1 of the Digi device is seen by the RealPort software 
as COM 3. Once the RealPort driver has been installed, you can modify the 
COM port numbering scheme.

Configuring the Digi Device
To configure the Digi device for RealPort, you must do the following:

• Configure the device with an IP address.

• Configure ports for RealPort. 

Master Setup Process
Use this topic to identify all the tasks required to complete RealPort setup.

Procedure
1. Configure the Digi device for RealPort.

See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on 
page 136 for configuring RealPort on a Digi CM device.

2. Install (or download) and configure the RealPort driver. 

• You may download the driver or install it from a CD. Some product 
CDs may have a script or wizard to perform these steps for you. 

3. Configure peripherals on RealPort ports. See the following:

• "Configuring a Printer" on page 16

• "Configuring a Modem" on page 17

Managing the RealPort Driver

Managing the RealPort driver involves either upgrading, removing, 
accessing or changing the RealPort Configuration. Use the following 
procedure to upgrade the RealPort driver. It is assumed that you have 
already downloaded the driver files or installed them from a CD. Some 

Chapter 2 M i c r o s o f t  W i n d o w s  S e r v e r  2 0 0 3 / 2 0 0 0 / X P
 R e a l P o r t  I n s t a l l a t i o n
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product CDs may have a script or wizard to perform these steps for you. 
Use this procedure to upgrade a Digi RealPort device driver that is installed 
in your system. Digi drivers may be delivered on a CD-ROM or downloaded 
from the Digi Support Web (http://www.digi.com/support). 

Upgrade RealPort 
There are two CDs that ship with the RealPort driver and depending on 
your product, you will receive one or the other. The Software and 
Documentation CD has the set up wizard, select Cancel and click 
Software. The Access Resource CD asks for your Operating System, 
Hardware, and Software. 
1. Select RealPort.

2. Select Install RealPort driver.

3. Select Update Digi RealPort Software.

4. Follow the wizard.

5. Click Finish to complete the wizard.

Remove RealPort 
1. From the CD, cancel the set up wizard and select Software.

2. Select Install RealPort driver.

3. Select Remove an Existing Device.

4. Follow the wizard.

5. Click Finish to complete the wizard.

Accessing and Changing the RealPort Configuration
Use these procedures to access and/or change the RealPort configuration. 
Configuration changes might include adding or removing ports or changing 
port attributes.

Procedure
1. Right click My Computer. 

2. Choose Properties > Hardware > Device Manager. 

3. Locate Multi-port Serial Adapters and expand the list if necessary. 

4. Choose the Digi terminal server device, right click and then choose 
Properties > Advanced. 

5. Use the Digi device's Properties utility and the online help for aid in 
making configuration changes.

Configure Encrypted RealPort
Encrypted RealPort is a security measure to maintain data integrity. In 
other words, prevent unauthorized changes in data including intentional 
destruction or alteration, tampering, duplication, or accidental loss. 
Encrypted RealPort also prevents disclosure to unauthorized individuals or 
processes. If your data is sensitive, Encrypted RealPort is strongly 
recommended. To implement Encrypted RealPort use the following 
procedure:
15 Chapter 2   Microsoft Windows Server 2003/2000/XP RealPort Installation 



1. From the Start Menu, click Settings > Control Panel > Administrative 
Tools > Computer Management > System Tools > Device Manager > 
Multi-port Serial Adapters

2. Select your device, click the Advanced tab, click Properties and click 
the Network tab.

3. Enable the Encrypt Network Traffic box. 

Note: The TCP port for encrypted traffic default setting is 1027. This must agree 
with the device TCP port setting which can be configured through the web 
interface by entering the IP address in URL address bar. Under Network > 
Network Services Settings > Select Enable Encrypted RealPort and verify the 
port number as 1027. (The Encrypted RealPort TCP port number must match 
the device port number.) Click Apply - you do not need to reboot.

4. Click Ok and Apply.

Configuring a Printer
Use this procedure to configure a printer on a Microsoft Windows Server 
2003/2000/XP system that is running RealPort. Using the Classic Start 
menu. To change to the Classic Start menu, right-click the Start button and 
choose Properties > Classic Start menu.

Procedure
1. From the Start menu, choose Settings > Printers and Faxes > Add 

Printer. 

2. From the Add Printer Wizard, choose Next > select Local printer 
attached to this computer and uncheck the box Automatically detect 
and install my Plug and Play printer. 

3. Choose Use the following port and scroll to the port to be assigned the 
printer > Next. 
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4. From the Install Printer Software screen, choose the printer attached to 
the RealPort port > Next. 

5. Accept the default name or enter a name for the printer > choose 
whether to make it the default printer or not > Next.

6. Choose Yes to print a test page > Next > Finish. The system does not 
need to be rebooted.

Configuring a Modem
Use this procedure to configure a modem on a Digi terminal server port 
using the Classic Start menu. To change to the Classic Start menu, right-
click the Start button and choose Properties > Classic Start menu.

Procedure
1. From the Start Menu, choose Settings > Control Panel > Phone and 

Modem Options. 

2. Choose the Modem tab and then Add. From the Install New Modem 
screen choose to have Windows detect the modem or to select the 
modem from a list.

3. If the Windows Server 2003/2000/XP system does not autodetect the 
proper modem, select the correct modem. 

4. Follow the Windows Server 2003/2000/XP prompts to install and set up 
the modem on a Digi port. 

Starting and Stopping the RealPort Driver
Use this procedure to start or stop the RealPort driver on Microsoft 
Windows Server 2003/2000/XP.

Procedure
1. Right-click on My Computer, choose Properties > Hardware tab > 

Device Manager. 

Expand the Multi-port Serial Adapters list if necessary and select the 
terminal server. 
2. Right-click and choose Disable to stop the service or Enable to start the 

RealPort driver. 

Troubleshooting RealPort in Windows: 

None of the Ports work:
1. Make sure the RealPort driver available on our web site at 

http://www.digi.com/support.

2. Make sure the Digi Device/Terminal Server is running the latest 
firmware version available on our website at http://www.digi.com/
supportTo verify the Digi Device/Terminal Server is configured properly, 
from a command prompt  (or Start > Run), type:

telnet [IP_of_digi_unit] 20xx

Where 20XX would be replaced by 2000+[Port Number]. For example, to connect to port 
#1, type: 
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telnet [IP_of_digi_unit] 2001

By inserting the loopback plug shipped with the Digi Device/Terminal 
Server into the port, you will be able to view any data being typed.  
Removing the loopback plug will not display any data typed.  
If the loopback test fails, the Digi Device/Terminal Server is not configured 
properly.
If the loopback test works, the Digi Device/Terminal Server is configured 
properly.
3. If you haven’t already verified the RealPort host can reach the Digi 

Device/Terminal Server above, please do so now by typing the following 
from a command prompt (or Start > Run):

telnet [IP_of_digi_unit] 771

You should get a blank window with a cursor.  If you do not, then RealPort 
cannot connect to the Digi Device/Terminal Server because the socket it 
uses to communicate (771) is in use, being blocked or fire walled.

Note: You will not be able type anything in this window, but you may see two line “||” 
that repeat.  This is nothing to be concerned with.  It is the drivers built in 
keepalive.

4. If you still cannot communicate after verifying the RealPort host can 
reach the Digi Device/Terminal Server, try reinstalling the driver.  If this 
does not resolve the problem, see "Troubleshooting Overview" on page 
138.

Some of the Ports do not work:
1. Check for active processes that maybe running on that port by logging 

into the Digi Device/Terminal Server via Telnet.  At the root prompt, 
type:

#>  who

    If there appears to be a process on the port, try killing it with the following 
    command:  

#>  kill tty=#

Note:     Rebooting the unit can also clear the process.

2. Test the non-working port with Hyperterminal: Choose Start > 
Accessories > Communications > Hyperterminal.

3. Type in a name, and choose an icon. It really doesn't matter what you 
choose for a name or icon. Choose OK when finished.

4. In the “Connect To” dialog box go to the connect using drop down list 
and choose the com port you wish to test. Choose OK when finished.

5. For testing with the loopback the defaults port settings are fine. Choose 
OK.

6. Insert the loopback plug, which ships with the Digi Device/Terminal 
Server,into whichever port you decided to test. You should see a 
blinking cursor on the main Hyperterminal screen. If you get a         
"Unable to open comX" message, this means the port is already open, 
make sure all applications that might be accessing the port are closed, 
Chapter 2  Microsoft Windows Server 2003/2000/XP RealPort Installation  18



or their services have been stopped (faxing applications, RAS, Citrix 
MetaFrame, etc.).

7. Type Hello! on the Hyperterminal screen. These characters should 
appear as you type them.

If the loopback test does not pass, see "Troubleshooting Overview" on 
page 138. 
8.  Test your serial device on a standard COM port (i.e. COM1/COM2)

If the loopback test passed and the serial device works on a standard COM 
port (i.e. COM1/COM2), verify the following:
a. Cabling: 
http://www.digi.com/support

b. Check Advanced Serial Settings: The RealPort driver supports an 
additional set of advanced features, each of which can be enabled or 
disabled from the Advanced properties of the Digi Device driver.  

Note: For more information on what these specific settings can be found in the 
Release Notes.  Read through them to determine if any of these options 
should be enabled.

If you have not resolved your problem at this point, please write down how 
far you were able to get in the above procedure (and the results) to 
describe your problem. See "Troubleshooting Overview" on page 138 for 
contact information and additional troubleshooting recommendations.
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About RealPort
RealPort software can be installed on one or more host servers to provide 
local serial port functionality. RealPort can be used to provide standard 
system COM, AIO or TTY interfaces to control baud rate, parity, stop bits, 
and flow control of local serial ports. Any system utility or user application 
that works with a locally attached serial port should work with a Digi 
RealPort port.
Digi's RealPort software works with all the Digi One RealPort,  Digi 
Connect, PortServer and EtherLite products.

Requirements
• The RealPort driver for Microsoft Windows NT requires between 

one and two MB of memory on the Windows NT system. 

• The Windows NT RealPort driver requires a 10-pin RJ-45 cable to 
connect devices to Digi One RealPort or PortServer ports. 

Limitations

• Only TAPI-compliant applications or those written to COM 32 API 
(application programming interface) standards can use intelligent 
ports, which means only these applications can use RealPort ports. 

Key Concept: About Port Mapping Offsets
The number of local ports on the Windows NT host offsets the port number 
on the Digi device. For example, if you have two local COM ports, Port 1 of 
the Digi device is seen by the RealPort driver as COM 3.

Configuring the Digi Device 
To configure the Digi device for RealPort, you must do the following:

• Configure the device with an IP address.

• Configure ports for RealPort. 

See "EtherLite RealPort Installation" on page 128 for configuring RealPort 
on an Etherlite device or "Digi CM RealPort Installation" on page 136 for 
configuring RealPort on a Digi CM device.

Setup Process
Use this topic to identify all the tasks required to complete RealPort setup.

Procedure
1. Install (or download) and configure the RealPort driver. 

• You may download the driver or install it from a CD. Some product 
CDs may have a script or wizard to perform these steps for you. 

Chapter 3 M i c r o s o f t  W i n d o w s  N T  4 . 0  R e a l P o r t
I n s t a l l a t i o n
Chapter 3  Microsoft Windows NT 4.0 RealPort Installation  20



(This step is accomplished during driver installation for Etherlite 
units.) 

2. Reboot the system to make RealPort ports available to the operating 
system.

3. Configure peripherals on the RealPort ports. See the following:

• "Configuring a Printer" on page 22

• "Configuring a Modem" on page 23

Install RealPort Driver on Microsoft Windows NT4 
Use this procedure to install the RealPort driver. It is assumed that you 
have already downloaded the driver files or installed them from a CD. 
Some product CDs may have a script or wizard to perform these steps for 
you. 
1. Click Start, click Settings, and then click Control Panel. 

2. Double-click Network and then click the Services tab. 

3. Click Add and then click Have Disk. 

4. Type the path to the RealPort files and click OK, or click Browse and 
locate the files. 

5. Select Digi RealPort Driver and click OK. 

6. Follow the prompts on the screen to finish installing RealPort. 

Update RealPort on Microsoft Windows NT4 
1. Click Start, click Settings, and then click Control Panel. 

2. Double-click Network and then click the Services tab. 

3. In the Network Services list, select Digi RealPort Driver and click 
Remove 

4. In the following Warning dialog, click Yes to confirm the permanent 
component removal. 

5. Click Close to close the Network dialog and then click Yes to restart 
your computer. 

6. When the computer has restarted, click Start, click Settings, and then 
click Control Panel. 

7. Double-click Network and then click the Services tab. 

8. Click Add and then click Have Disk. 

9. Type the path to the RealPort files and click OK 

10.Select Digi RealPort Driver and click OK 

11. Follow the prompt on the screen to finish updating RealPort. 

Accessing and Changing the RealPort Configuration
Use these procedures to access and/or change the RealPort configuration. 
Configuration changes might include adding or removing ports or changing 
port attributes.
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Procedure
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose the Digi RealPort Driver and then Properties.

3. Choose a Digi device and then Properties.

4. When the RealPort Properties page appears, use the help text to guide 
you through configuration procedures.

Removing the Driver
Use this procedure to remove RealPort from your system.

Procedure
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose Digi RealPort Driver and then Remove.

3. Follow the prompts to complete removal.

Configuring a Printer
Use this procedure to configure a printer on a Microsoft Windows NT 
system that is running RealPort.

Note: This procedure requires you to restart the computer. Therefore, print this topic 
to avoid having to relocate it when the system restarts.

Procedure
1. From the Start menu, choose Settings > Printers > Add Printer.

2. From the Add Printer Wizard, choose My Computer > Next.

3. From the list of available ports, choose LPT1 (temporarily, until RealPort 
ports are added) and then Next.

4. Use the Add Printer Wizard to install and configure a printer driver. 

Do not print a test page.
5. When the new printer is displayed in the Printers menu, choose the new 

printer and then File > Properties.

6. Choose the Ports tab and then Add Port... > Local Port > New Port.

7. Type in a Digi port name followed by a colon (example: COM18:) and 
then choose OK.

8. When the Ports list appears, choose the new Digi port and then Add.

9. Choose the Digi port in the COM Port field and then OK.

10.When you are prompted to reboot your system, choose Don't Restart 
Now.

11. Choose the Digi port and then Settings.

12.Set the Baud Rate, Data Bits, Parity, Stop Bits, and Flow Control to 
match your printer configuration.
Note: Changing the baud rate of a serial printer requires deleting the printer device 

and then re-adding the device with a different baud rate. If you plan to use the 
RealPort driver with serial printers, you have to reboot the system after device 
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installation or after renaming ports to see the new ports listed in the Print 
Spooler's list of available ports for printing. If you experience problems 
printing to a serial printer, navigate to the device's Device Properties dialog in 
the Device Manager, enable "Complete Write Requests Immediately," and try 
printing again. 

Note: There is a single bit in the line control register for setting stop bits.  If this bit is 
set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

13.Choose OK and then exit the printer configuration.

14.Reboot your system and then return to the Printer menu.

15.Choose the printer and then File > Properties > Ports.

16.Choose the Digi port from the list and then OK.

Configuring a Modem
Use this procedure to configure a modem on a Digi port on a Microsoft 
Windows NT system.

Procedure
1. From the Start Menu, choose Settings > Control Panel > Modems.

2. Choose Add > Next (which will autodetect the modem). If the Windows 
NT system does not autodetect the proper modem, select the modem.

3. Follow the Windows NT 4.0 prompts to install and set up the modem on 
a Digi port.

Starting and Stopping the RealPort Driver
Use this procedure to start or stop RealPort driver on Microsoft Windows 
NT.

Procedure
1. From the Start menu, choose Settings > Control Panel > Devices > Digi 

RealPort.

2. Choose Stop or Start.

Troubleshooting RealPort in Windows: 

If none of the ports work:
1. Make sure the RealPort driver available on our web site at 

http://www.digi.com/support.

2. Make sure the Digi device is running the latest firmware version 
available on our website at http://www.digi.com/supportTo verify the Digi 
device is configured properly, from a command prompt  (or Start > Run), 
type:

telnet [IP_of_digi_unit] 20xx

Where 20xx would be replaced by 2000+[Port Number]. For example, to 
connect to port #1, type:
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telnet [IP_of_digi_unit] 2001

By inserting the loopback plug shipped with the Digi device into the port, you will be able to 
view any data being typed.  Removing the loopback plug will not display any data typed.  

If the loopback test fails, the Digi device is not configured properly.
If the loopback test works, the Digi device is configured properly.

3. If you haven’t already verified the RealPort host can reach the Digi 
device above, please do so now by typing the following from a 
command prompt (or Start > Run):

telnet [IP_of_digi_unit] 771

You should get a blank window with a cursor.  If you do not, then RealPort cannot connect 
to the Digi device because the socket it uses to communicate (771) is in use, being 
blocked or fire walled.

Note: You will not be able type anything in this window, but you may see two line “||” 
that repeat.  This is nothing to be concerned with.  It is the drivers built in 
keepalive.

4. If you still cannot communicate after verifying the RealPort host can 
reach the Digi device, try reinstalling the driver.  If this does not resolve 
the problem, "Troubleshooting Overview" on page 138.

If some of the ports do not work:
1. Check for active processes that maybe running on that port by logging 

into the Digi deviceDigi device via Telnet.  At the root prompt, type:
#>  who

    If there appears to be a process on the port, try killing it with the following 
    command:  

#>  kill tty=#

Note:     Rebooting the unit can also clear the process.
2. Test the non-working port with Hyperterminal: Choose Start > 

Accessories > Communications > Hyperterminal.

3. Type in a name, and choose an icon. It really doesn't matter what you 
choose for a name or icon. Choose OK when finished.

4. In the “Connect To” dialog box go to the connect using drop down list 
and choose the com port you wish to test. Choose OK when finished.

5. For testing with the loopback the defaults port settings are fine. Choose 
OK.

6. Insert the loopback plug, which ships with the Digi device, into 
whichever port you decided to test. You should see a blinking cursor on 
the main Hyperterminal screen. If you get a         "Unable to open comX" 
message, this means the port is already open, make sure all 
applications that might be accessing the port are closed, or their 
services have been stopped (faxing applications, RAS, Citrix 
MetaFrame, etc.).

7. Type Hello! on the Hyperterminal screen. These characters should 
appear as you type them.

If the loopback test does not pass, see "Troubleshooting Overview" on page 138.
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8.  Test your serial device on a standard COM port (i.e. COM1/COM2)

If the loopback test passed and the serial device works on a standard COM 
port (i.e. COM1/COM2), verify the following:
a. Cabling: 
http://www.digi.com/support
b. Check Advanced Serial Settings: The RealPort driver supports an 
additional set of advanced features, each of which can be enabled or 
disabled from the Advanced properties of the Digi device driver.  

Note: For more information on what these specific settings can be found in the 
Release Notes.  Read through them to determine if any of these options 
should be enabled.

If you have not resolved your problem at this point, please write down how 
far you were able to get in the above procedure (and the results) to 
describe your problem. See "Troubleshooting Overview" on page 138 for 
contact information and additional troubleshooting recommendations.
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Requirements
• The RealPort driver for Microsoft Windows 9x/Me requires between 

one and two MB of memory on the Windows 9x/Me system. 

• The Windows 9x/Me RealPort driver requires a 10-pin RJ-45 cable 
to connect devices to Digi One RealPort or PortServer ports. 

Limitations
Only TAPI-compliant applications or those written to COM 32 API 
(application programming interface) standards can use intelligent ports, 
which means only these applications can use RealPort ports. 

Key Concept: About Port Mapping Offsets
The number of local ports on the Windows 9x/Me host offsets the port 
number on the Digi device. For example, if you have two local COM ports, 
Port 1 of the Digi device is seen by the RealPort driver as COM 3.

Configuring the Digi Device 
To configure the Digi device for RealPort, you must do the following:

• Configure the device with an IP address.

• Configure ports for RealPort. 

See "EtherLite RealPort Installation" on page 128 for configuring RealPort 
on an Etherlite device or "Digi CM RealPort Installation" on page 136 for 
configuring RealPort on a Digi CM device.

Setup Process
Use this topic to identify all the tasks required to complete RealPort setup.

Procedure
1. Install (or download) and configure the RealPort driver. 

• You may download the driver or install it from a CD. Some product 
CDs may have a script or wizard to perform these steps for you. 

2. Configure the Digi device for RealPort. (This step is accomplished 
during driver installation for Etherlite units.) 

3. Reboot the system to make RealPort ports available to the operating 
system.

4. Configure peripherals on the RealPort ports. See the following:

• "Configuring a Printer" on page 29

• "Configuring a Modem" on page 29

Installing the Driver: Download or Integration Kit
Use this procedure when to install the Windows 9x/Me RealPort driver after 
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you download it from the Digi web site.
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose Add > Have Disk....

3. Type in the path to where the RealPort files are stored and then choose 
OK.

4. Choose Digi RealPort Driver and then OK. 

The files are installed and the configuration wizard is started. 
5. If you are using an Etherlite unit that has not been assigned IP settings, 

do the following to assign the settings:

6. Press the DgIPServ button.

7. Use the wizard and the associated help text to assign IP settings to the 
Etherlite unit.

8. When you finish, return to the Add Digi RealPort wizard.

9. Use the Add Digi RealPort wizard and the associated help text to 
configure the RealPort driver with the IP address and TCP port number 
used by the Digi device.

10.Follow the prompts to complete configuration of the RealPort driver.

Installing the Driver: CD
Use this procedure to install the Windows 9x/Me RealPort driver from the 
Digi CD. This procedure assumes that you have already started the Digi 
CD front-end menu program. Navigate the CD front-end to your RealPort 
installation.
1. Click the Run Add New Hardware button at the bottom of the 

instructions.

2. Click Next > Next. The wizard searches for devices and asks if the 
device you want to install is listed below.

3. Click “No, the device isn’t in the list” then click Next.

4. Click “No, I want to select the device from a list” then click Next.

5. Scroll down and select Other devices and click Next.

6. Click Have Disk.

7. Click Control-V when prompted for the path and click OK.
Note: If the name does not appear in the path, enter 

D:/drivers/windows/win9x/realport where D = the CD ROM drive.

8. Select your device from the list that appears and click Next.

9. Click Finish to complete the configuration.

If you are using an Etherlite unit that has not been assigned an IP 
address, do the following to assign an address:

10.Press the DgIPServ button.
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11. Use the wizard and the associated help text to assign an IP address to 
the Etherlite unit.

12.When you finish, return to the Add Digi RealPort wizard.

13.Use the Add Digi RealPort wizard and the associated help text to 
configure the RealPort driver with the IP address and TCP port number 
used by the Digi device. For Etherlite units, this is the IP address 
assigned in the previous step.

14.Follow the prompts to complete configuration of the RealPort driver.

Upgrade RealPort on Microsoft Windows 98 or 
Microsoft Windows Me 
Use this procedure to upgrade the RealPort driver. It is assumed that you 
have already downloaded the driver files or installed them from a CD. 
Some product CDs may have a script or wizard to perform these steps for 
you. 
1. Click Start >Settings > Control Panel. 

2. Double-click System > Device Manager tab. 

3. Double-click Multi-port Serial Adapters > double-click the device you 
would like to update. 

4. On the Driver tab, click Update Driver to start the Update Device Driver 
Wizard and click Next. 

5. Click Search for a better driver than the one your device is using now 
(Recommended) and click Next. 

6. Clear all check boxes, then select the Select a location check box. 

7. Type the path to the RealPort files and click OK, or click Browse and 
locate the files.

8. Click One of the other drivers and click View List 

9. In the list, select the driver you are updating, click OK, click Next > Next. 

10.Click OK to confirm the Add New Digi Hardware dialog, click Finish to 
close the Update Device Driver Wizard and then click Close to close the 
Device Properties dialog. 

11. Repeat steps 3 to 10 for each device you would like to update. 

12.Close the Device Manager and restart your computer to let the changes 
take effect. 

Accessing and Changing the RealPort Configuration
Use these procedures to access and/or change the RealPort configuration. 
Configuration changes might include adding or removing ports or changing 
port attributes.

Procedure
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose the Digi RealPort Driver and then Properties.
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3. Choose a Digi device and then Properties.

4. When the RealPort Properties page appears, use the help text to guide 
you through configuration procedures.

Configuring a Printer
Use this procedure to configure a printer on a Microsoft Windows 9x/Me 
system that is running RealPort.

Note: This procedure requires you to restart the computer. Therefore, print this topic 
to avoid having to relocate it when the system restarts.

Procedure
1. From the Start menu, choose Settings > Printers > Add Printer.

2. From the Add Printer Wizard, choose My Computer > Next.

3. From the list of available ports, choose LPT1 (temporarily, until RealPort 
ports are added) and then Next.

4. Use the Add Printer Wizard to install and configure a printer driver. 

Do not print a test page.
5. When the new printer is displayed in the Printers menu, choose the new 

printer and then File > Properties.

6. Choose the Ports tab and then Add Port... > Local Port > New Port.

7. Type in a Digi port name followed by a colon (example: COM18:) and 
then choose OK.

8. When the Ports list appears, choose the new Digi port and then Add.

9. Choose the Digi port in the COM Port field and then OK.

10.When you are prompted to reboot your system, choose Don't Restart 
Now.

11. Choose the Digi port and then Settings.

Note: Set the Baud Rate, Data Bits, Parity, Stop Bits, and Flow Control 
to match your printer configuration.

Note: There is a single bit in the line control register for setting stop bits.  If this bit is 
set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

12.Choose OK and then exit the printer configuration.

13.Reboot your system and then return to the Printer menu.

14.Choose the printer and then File > Properties > Ports.

15.Choose the Digi port from the list and then OK.

Configuring a Modem
Use this procedure to configure a modem on a Digi port on a Microsoft 
Windows 9x/Me system.

Procedure
1. From the Start Menu, choose Settings > Control Panel > Modems.
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2. Choose Add > Next (which will autodetect the modem). If the Windows 
9x/Me system does not autodetect the proper modem, select the 
modem.

3. Follow the Windows 9x/Me prompts to install and set up the modem on 
a Digi port.

Starting and Stopping the RealPort Driver
Use this procedure to start or stop RealPort driver on Microsoft Windows 
9x/Me.

Procedure
1. From the Start menu, choose Settings > Control Panel > Devices > Digi 

RealPort.

2. Choose Stop or Start.

Removing the Driver
Use this procedure to remove RealPort from your system.

Procedure
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose Digi RealPort Driver and then Remove.

3. Follow the prompts to complete removal.

Troubleshooting RealPort in Windows: 

If none of the ports work:
1. Make sure the RealPort driver available on our web site at

 http://www.digi.com/support.

2. Make sure the Digi device is running the latest firmware version 
available on our website at http://www.digi.com/support.

3. To verify the Digi device is configured properly, from a command prompt  
(or Start > Run), type:

telnet [IP_of_digi_unit] 20xx

Where 20xx would be replaced by 2000+[Port Number]. For example, to 
connect to port #1, type:

telnet [IP_of_digi_unit] 2001

By inserting the loopback plug shipped with the Digi device into the port, 
you will be able to view any data being typed.  Removing the loopback plug 
will not display any data typed.  
If the loopback test fails, the Digi device is not configured properly.
If the loopback test works, the Digi device is configured properly.
4. If you haven’t already verified the RealPort host can reach the Digi 

device above, please do so now by typing the following from a 
command prompt (or Start > Run):
Chapter 4  Microsoft Windows 9x/Me RealPort Installation  30

http://www.digi.com
http://www.digi.com
http://www.digi.com


telnet [IP_of_digi_unit] 771

You should get a blank window with a cursor.  If you do not, then RealPort 
cannot connect to the Digi device because the socket it uses to 
communicate (771) is in use, being blocked or fire walled.

Note: You will not be able type anything in this window, but you may see two line “||” 
that repeat.  This is nothing to be concerned with.  It is the drivers built in 
keepalive.

5. If you still cannot communicate after verifying the RealPort host can 
reach the Digi device, try reinstalling the driver.  If this does not resolve 
the problem, see "Troubleshooting Overview" on page 138.

If some of the ports do not work:
1. Check for active processes that maybe running on that port by logging 

into the Digi device via Telnet.  At the root prompt, type:
#>  who

    If there appears to be a process on the port, try killing it with the following 
    command:  

#>  kill tty=#

Note:     Rebooting the unit can also clear the process.
2. Test the non-working port with Hyperterminal: Choose Start > 

Accessories > Communications > Hyperterminal.

3. Type in a name, and choose an icon. It really doesn't matter what you 
choose for a name or icon. Choose OK when finished.

4. In the “Connect To” dialog box go to the connect using drop down list 
and choose the com port you wish to test. Choose OK when finished.

5. For testing with the loopback the defaults port settings are fine. Choose 
OK.

6. Insert the loopback plug, which ships with the Digi device, into 
whichever port you decided to test. You should see a blinking cursor on 
the main Hyperterminal screen. If you get an  "Unable to open comX" 
message, this means the port is already open, make sure all 
applications that might be accessing the port are closed, or their 
services have been stopped (faxing applications, RAS, Citrix 
MetaFrame, etc.).

7. Type Hello! on the Hyperterminal screen. These characters should 
appear as you type them.

If the loopback test does not pass, see "Troubleshooting Overview" on page 138.
8.  Test your serial device on a standard COM port (i.e. COM1/COM2)

If the loopback test passed and the serial device works on a standard COM 
port (i.e. COM1/COM2), verify the following:
a. Cabling:
http://www.digi.com/support
b. Check Advanced Serial Settings: The RealPort driver supports an 
additional set of advanced features, each of which can be enabled or 
disabled from the Advanced properties of the Digi device driver.  
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Note: For more information on what these specific settings can be found in the 
Release Notes.  Read through them to determine if any of these options 
should be enabled.

If you have not resolved your problem at this point, please write down how 
far you were able to get in the above procedure (and the results) to 
describe your problem. See "Troubleshooting Overview" on page 138 for 
contact information and additional troubleshooting recommendations.
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Requirements and Considerations

Read this section before beginning the RealPort driver installation.
• The SCO OpenServer RealPort driver is compatible with SCO 

OpenServer System 5.0.4, 5.0.5, 5.0.6., and 5.0.7. The SCO 
OpenServer RealPort driver is not compatible with SCO UnixWare.

• Installing the RealPort software on a SCO OpenServer host where 
RealPort has already been installed necessitates the removal of the 
existing RealPort driver. During the removal of the previous driver, 
the user is prompted to save the old configuration. 

• During a new installation of the driver, the system prompts the user 
to approximate the number of Digi devices that might be configured 
with RealPort. It is best to configure extra Digi devices during the 
initial RealPort configuration. By doing this, additional Digi devices 
can be connected later without relinking and rebooting the system. 

• The Digi RealPort driver for SCO OpenServer is an installable 
device driver. The software development system is not required to 
create a new kernel.

• Encrypted RealPort is a security measure to maintain data integrity. 
In other words, prevent unauthorized changes in data including 
intentional destruction or alteration, tampering, duplication, or 
accidental loss. Encrypted RealPort also prevents disclosure to 
unauthorized individuals or processes. SCO OpenServer supports 
Encrypted RealPort but EtherLite, Digi Flex, and older PortServer 
products do not.

• The RealPort package includes software developed by the 
OpenSSL project for use in the OpenSSL toolkit 
(http:www.openssl.org)

— The OpenSSL software requires an external random number 
generator on the system. If you want to use the encrypted layer 
in the driver you must install PRNGD (Psuedo Random Number 
Generator Daemon)

— The PRNGD package for Open Server may be obtained from 
SCO.
PRNGD is a third party software package and not supported by Digi Tech Support.

Information to Gather

Before you install RealPort, you need to determine:
• The hostname or IP address to assign each unconfigured Digi 

device. 

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 
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• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Configure the Digi Device

Use these procedures to configure a Digi device from the Digi One, Digi 
Connect,  PortServer, and Digi Flex families for use with Digi RealPort 
drivers. See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on page 
136 for configuring RealPort on a Digi CM device.

Procedure Overview
1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 
Note: The RealPort TCP port number is set to 771 as the default. If you have trouble 

with your configuration after following the steps listed below, check to verify 
that the RealPort TCP port number has not been changed and is set to 771.To 
ensure this setting is correct, use set config realport=771. 

3. Set the device type to rp for all ports that will be using RealPort.

4.  Reboot unit for settings to take effect.

Access the Root Prompt
1. Connect a terminal cable to any port on the device (and the terminal).

2. Configure the terminal for VT-100 Emulation, 9600 baud, 8 data bits, 1 
stop bits, and no parity.
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

3. Plug in the power supply to the Digi device (most devices will power up 
but the larger devices have a power switch).

4. Press Enter or Return on the keyboard.

5. Enter root at the login prompt.

6. Enter dbps (the default password).

Set the IP Address
1. Set IP address with the setconfig command:

     set config ip= [ipaddress]

2. Set any relevant setconfig parameters such as name server or gateway.

Set Device Type
The following example configures ports 2 through 16 of a PortServer for 
RealPort: 

set ports range=2-16 dev=rp
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Reboot Unit
Reboot the device for settings to take effect:

      boot action=reset 

Setting Altpin 

If you are using an 8-pin RJ-45 cable connecting a Digi serial port to a 
modem or printer, altpin must be set on the PortServer devices in order to 
get DCD signal functionality. Altpin cannot be set in the device driver. To 
enable altpin on the Digi device, do the following: 
Telnet to the Digi device by using the following command:

telnet ipaddress

an example is: telnet 155.204.23.56
3. From the prompt, enter the following command:

set flow altpin=on range=port

where port is the number or numbers of the ports

Master Setup Process
Use this process to install and configure the SCO OpenServer RealPort 
driver.
1. Read any release notes that may be included with the installation 

media. 

2. Gather information necessary for installation. See "Information to 
Gather" on page 34. 

3. Install the RealPort driver. "Installing the Driver: Download or 
Integration Kit" on page 36 or "Installing the Driver: CD" on page 37. 

4. Configure the PortServer for RealPort. See "Configure the Digi Device" 
on page 35, or "Master Setup Process" on page 36. 

Installing the Driver: Download or Integration Kit
1. Download the appropriate driver package file. 

2. Copy the downloaded package file to a directory on the SCO 
OpenServer system. 

3. Log in as root on the SCO OpenServer system. 

4. Change to the directory into which you copied the package file. 

5. Enter the following command: 
custom -i -p misc:drp -F `pwd`/file_name

6. where file_name is the name of the downloaded driver package.

7. Follow the prompts.
Note: In order to prevent having to reboot your system (and potentially loosing all 

previous settings) make an estimate of devices to accomodate future 
additions. If you underestimate the number of devices to add, the system will 
prompt you to verify that you want to add more devices and you must reboot 
for the devices to function. Estimating a high number will prevent you from 
having to reboot.
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Note: You will be prompted with the following to install Encrypted RealPort: 

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always

The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y

8. Confirm your configuration.

9. Reboot the system when the installation is complete. 

The RealPort package includes software developed by the OpenSSL 
project for use in the OpenSSL toolkit (http:www.openssl.org)

— The OpenSSL software requires an external random number 
generator on the system. If you want to use the encrypted layer 
in the driver you must install PRNGD (Psuedo Random Number 
Generator Daemon)

— The PRNGD package for Open Server may be obtained from 
SCO.
PRNGD is a third party software package and not supported by Digi Tech Support.

Installing the Driver: CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.

Uninstalling RealPort
The Digi device driver software can be removed from the kernel by using 
custom. The Development Kit is not required, although the link kit must be 
installed.
1. Log onto the console as super-user (root) and enter this command:

custom -i -p misc:drp -F ‘pwd‘/file_name 

2. Choose Software > Remove from the menu that appears. 

3. Choose Digi RealPort.

4. Exit custom. 

5. Enter the following command to shut the system down and boot the 
new kernel: 

shutdown -y -g0
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Add, Configure, or Delete a Digi Device with drpadmin
The new Digi RealPort driver allows a user to add or remove Digi devices 
on their systems without having to relink or reboot the kernel each time a 
device is added or removed. This feature is achieved with the drpadmin 
utility.
During the driver package installation, the user is prompted to reserve 
additional devices to accommodate future additions. No other information 
is requested at that time. If the user, however, underestimates the number 
of Digi devices and needs to add more devices at a later date, the 
drpadmin utility allows the user to add devices as needed. These new 
unreserved devices require the kernel be relinked. The drpadmin utility 
relinks the unreserved devices automatically, but the user must perform a 
system reboot to load the new kernel.

Procedure
1. Enter this command at a root prompt: 

/usr/bin/drpadmin

2. Answer the prompts as appropriate. 

Create RealPort Devices
The RealPort installation creates four different devices for each port in the

Prompt Action

Select an option Choose add.

Enter the host name or IP 
address for this Digi device

If an IP address is used, make sure it is unique and 
does not conflict with any other network device.
If a name is entered, the name must be registered in 
/etc/hosts or with an accessible nameserver.

Enter the number of ports 
on the Digi device

Enter the number of ports for this Digi device. The 
installation will prompt to confirm this number.
If PORTS/Xem (EBI) modules will be attached to a 
PortServer II module, include these ports.

Enter TTY device ID let-
ter(s) 

Enter one or two letters. These letters will be used to 
create the RealPort device names.

Would you like this 
RealPort session to be 
encrypted?

If you want the session encrypted enter always. The 
session will always remain encrypted.  If unable to 
create an encrypted session it will fail to work. 
If you do not want the session encrypted enter never. 
The session will never use encryption.
Check your documentation to verify if your Digi device 
supports Encrypted RealPort.

Enter WAN speed if the 
connection between the 
Digi device and HP-UX 
system includes a WAN link 
slower than 1 MB

Enter the WAN speed if this is the case. Otherwise, 
choose Enter to continue.

Confirm the configuration Enter y to proceed or n to reenter the information.

Select an option Enter a to add another Digi device. Enter s to show 
configured Digi devices. Enter q to exit drpadmin.
Chapter 5  SCO OpenServer RealPort Installation  38



 /dev directory.
• Standard device 

• Modem device 

• Standard transparent print device 

• Modem transparent print device 

Device Name Format
The devices are named according to the following conventions:

Here are examples of the devices for the first port of a Digi device with the 
identification letter "a":

Standard Device

Example: /dev/ttya01

A standard Digi device uses a lowercase identification letter in their names. 
The default handshake method is XON/XOFF. Data Carrier Detect (DCD) 
need not be present to open the device.
Once a connection is established and DCD becomes active, standard 
devices behave in the same way as modem devices--subsequent loss of 
the Data Carrier Detect signal will cause active processes on the port to be 
killed and the user will be automatically logged off.

Modem Device

Example: /dev/ttyA01

Digi modem devices use an uppercase identification letter in their names. 
They are sometimes referred to as "dial-in" devices.
Modem devices are traditional Unix ports with modem control. They require 
Data Carrier Detect to be high before they will operate. RTS/CTS 
handshaking is enabled by default. When used with a modem, the ports will 
wait for carrier before sending out the login: prompt
When used with a terminal or other device, it is usually wise to wire the Digi 

Syntax Description

a-z/aa-zz The Digi device letter ID. Single or double characters can be used.

01-64 The port number on the individual Digi device.

lowercase 
letter At the end of a device name indicates a standard device.

uppercase 
letter At the end of a device name indicates a modem device.

Device Path/Name Example
Standard Device /dev/ttya01

Modem Device /dev/ttyA01

Standard Transparent Print Device /dev/pra01

Modem Transparent Print Device /dev/prA01
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DCD signal to the terminal's Data Terminal Ready DTR) line. When the 
terminal is turned on, the system outputs a login prompt. When the terminal 
is turned off, any associated jobs are killed, and the user is logged out.

Transparent Print Devices

Examples: /dev/pra01 and /dev/prA01

The transparent print devices can be used with auxiliary printer ports on 
terminals. Output directed to a pr device goes out the auxiliary port of a 
terminal while you continue to use the terminal normally.
Use pra01 if the terminal device is ttya01 (standard device); use prA01 if 
the terminal device is ttyA01 (modem device).

Configuring a Device for a Terminal
Use this procedure to configure a Digi serial device for a terminal. See your 
operating system documentation for more information on configuring a 
serial device for a terminal.

Procedure
1. Connect a serial cable between the port and terminal. 

2. Edit the /etc/inittab file on the SCO OpenServer system. Change the 
device to the proper speed, data bits, stop bits and parity bit. Do this by 
editing the letter or number at the end of the line for the port (the default 
is m, which corresponds with 9600 8,1,N). See /etc/gettydefs for /etc/
inittab letter and number definitions. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

3. Enable the port for login by entering this command at a prompt: 
enable device

where device is the name of the Digi device.

Configuring a Device for a Printer 
Use this procedure to configure a Digi serial device for a printer. Consult 
your operating system documentation for more information on configuring 
a serial device for a printer.

Note: If you are using an 8-pin RJ-45 cable connecting a Digi serial port to a modem 
or printer, altpin must be set on the PortServer devices in order to get DCD 
signal functionality. Altpin cannot be set in the device driver. For information 
on how to set altpin, see "Setting Altpin" on page 36

Procedure
1. Connect a proper cable between the port and printer. 

Enter the following command at a root prompt to set up a print  
spooler: 

scoadmin printer

Note: See your SCO OpenServer documentation for information on scoadmin.
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2. Reboot the system or enter the ditty command manually for the new 
settings to take effect. 

Configuring a Device for a Modem
Use these procedures to configure a Digi serial device for a Dial-in/Dial-out 
modem connection. This scenario requires familiarity with both the modem 
and the operating system. While the following procedure is sufficient for 
most cases, it may be necessary to take additional steps to properly 
configure your modem or to set up the operating system for a specific 
application.

Note: If you are using an 8-pin RJ-45 cable connecting a Digi serial port to a modem 
or printer, altpin must be set on the PortServer devices in order to get DCD 
signal functionality. Altpin cannot be set in the device driver. For information 
on how to set altpin, see "Setting Altpin" on page 36

Procedure: Configuring the UNIX Device
1. Connect a serial cable between the port and modem. 

2. Power the modem on. 

3. Edit the /etc/inittab file on the SCO OpenServer server. Change the 
upper-case device to the letter o by editing the letter or number at the 
end of the line for the device. See /etc/gettydefs for inittab letter and 
number definitions. 

4. Disable the modem control and non modem control devices for the port 
by entering:

disable modem-control-device
disable non-modem-control-device

where modem-control-device is the name of the modem control device for the port 
and non-modem-control-device is the name of the non modem control device for the 
port.

5. Edit the file /usr/lib/uucp/Devices. Add a Direct line for the device like 
this: 

Direct ttyh1a - 38400 direct device

The "D" in Direct must be the first character on the line.

Procedure: Configuring Modems for Dial-in
1. Comment out any ACU lines relating to this device until dial-in is 

working properly. 
Note: Some applications may require an ACU entry in the Devices file. If an 

application requires an entry, refer to the modem manual or to the modem 
manufacturer for the correct modem initialization string, and to the SCO 
OpenServer Administration handbook for guidance on setting up an 
appropriate ACU entry that uses this initialization string.

2. Connect to the modem. At a root prompt, enter this command 
cu -l /dev/device -s 38400

where device is the name of the non modem control device for the port.

3. Set the modem to answer after the first ring with this command: 
ats0=1

4. Enter the following command to train the modem to the port speed: 
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at&w

5. Enter any other desired modem commands. 

6. Disconnect from the modem by entering a tilde and a period: 
~.

7. Configure flow control on the port. Hardware flow control is typical 
and can be configured by inserting this command at the end of the file 
/etc/rc.d/8/userdef: 

ditty rtspace ctspace -ixon device

8. To add dial-in capability, enter this command at a root prompt: 
enable device

an example is: enable ttyA01
In SCO OpenServer, the uppercase device name is for dial-in, the lowercase name is for 
dial-out and modem configuration.

Deleting a Digi Device with drpadmin

Procedure
1. Enter this command at a root prompt: 

/usr/bin/drpadmin

2. Enter s to show all installed Digi devices. 

3. Note the number of the Digi devices to delete. 

4. Choose Enter to make the options prompt reappear. 

5. Enter d (delete).
Note: r = reset  - this kills the daemon and then restarts it.

s = show - displays the host name, IP address, and other information

6. Enter the Digi device number to delete. 

7. Enter y to confirm the deletion. 

Transparent Printer Setup

About Transparent Printing
Most terminals have an auxiliary port that can be connected to a serial 
printer. When this port is configured as a transparent printer port, print jobs 
may be run simultaneously with normal terminal operation.
Data bound for the printer is preceded by a terminal escape sequence 
which turns on transparent printing, and followed by a sequence which 
turns transparent printing off.
Set up a transparent printer in the same way you would set up a printer 
wired directly to a serial port. Data sent to a transparent printer device is 
automatically "wrapped" in the transparent print on/off command strings for 
the specified printer.

Configuring Transparent Printers
Use this procedure to set up transparent printers on terminals. 

Note: This procedure sets up the communication characteristics for transparent 
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printers. Once a transparent printer has been set up, you can use it as you 
would a printer connected directly to a serial port. See your UNIX 
documentation for information on setting up print queues.

Procedure

At the command prompt, enter:
ditty -n ttyname [options]

where ttyname is the name of the terminal device and options are selected from the list 
below..

Setup Examples for Transparent Printing
Use the ditty program to set up your terminal for transparent printing.
The following command configures the transparent print options for a DEC 
VT100 terminal connected to /dev/ttya01 (note that the printer will be called 
/dev/pra01). maxcps, maxchar and bufsize are left to defaults. 

ditty term vt100 /dev/ttya01

The following example uses onstr and offstr arguments (this sets the 
terminal to use ANSI Standard). Again maxcps, maxchar, and bufsize are 
defaults. Enter on a single command line:

Option Description

maxcps n Limits the maximum printer port character-per-second data rate. n should be 
set to the minimum character rate the printer can sustain in typical use.

maxchar n 

Limits the number of characters queued to the printer ahead of terminal out-
put. Lower numbers increase system overhead, higher numbers result in key-
stroke echo delays. A value of 50 is generally a good compromise at 9600 
baud.

bufsize n 
This parameter should be set to a value just below the printer's buffer size. 
After a period of inactivity, the driver will burst up to this many characters to 
the printer to fill the print buffer before slowing to the maxcps rate.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the trans-
parent printer.
s is a string of ASCII characters, enclosed in quotes, that command the termi-
nal to enter transparent printing mode. An arbitrary octal character xxx may be 
given as \xxx.
For example, the sequence "<Esc>[5i" would be entered as:
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the printer.
s is a string of ASCII characters, enclosed in quotes, that command the termi-
nal to enter transparent printing mode. An arbitrary octal character xxx may be 
given as \xxx.
For example, the sequence "<Esc>[4i" would be entered as:
"\033[4i".

term t 

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminal types: 
adm31, ansi, dg200, dg210, hz1500, mc5, vt100, vt220, vt320, vt420, 
wang2x36, wyse30, wyse50, wyse60 or wyse75.
If the terminal type is not found in the internal default table, then ditty reads 
the terminfo entry for the terminal type and sets the transparent print on/off 
strings to the values given by the mc5/mc4 attributes found there.
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ditty onstr \033[5i offstr \033[4i /dev/ttya01

This example command sets the transparent print option for a WYSE30 
terminal, with maxcps of 75, a maxchar of 100, and a printer buffer size, 
bufsize, of 1000. Enter on a single command line:

ditty term wyse30 maxcps 75 maxchar 100 bufsize 1000 /dev/ttya01

Setting TTY Options
RealPort UNIX device driver packages include the ditty command, which is 
a superset of stty, and may be used to set and display the device options 
for Digi RealPort devices.
The general command format is:
ditty [-a] [-n ttyname] [option(s)] [ttyname]
With no options, ditty displays all Digi special driver settings, modem 
signals, and all standard parameters displayed by stty(1) for the TTY 
device referenced by standard input.
Command options are provided to change flow control settings, set 
transparent print options, force modem control lines, and display all TTY 
settings. Any unrecognized options are passed to stty(1) for interpretation.
ditty commands may be executed from the command line or placed in a 
startup script to be run whenever the system is booted.

The following options specify transient actions to be performed 
immediately:

Option Description

-a Display all of the unique Digi option settings, as well as all of the stan-
dard TTY settings reported by stty -a.

-n ttyname
Set and display options for the given TTY device, instead of standard 
input. This option may be specified multiple times to perform the same 
operation on multiple TTYs.

ttyname

Set and display options for the specified TTY device. Replace 
ttyname with the TTY pathname (such as /dev/ttya01s, /dev/term/a01 
or /dev/dty/a001s, depending on your operating system). This option 
may be used on a modem control line when no carrier is present.

Option Action
break Send a 250 MS break signal out on the TTY line.

flush Immediately flush (discard) TTY input and output.

flushin Flush TTY input only.

flushout Flush TTY output only.
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The following options specify actions which are not sticky, meaning that the 
changes are cancelled when the device is closed, and that the device will 
use the default values the next time it is opened..

The following options are sticky—the effects continue until the system is 
rebooted or until the options are changed.

Option Actions
stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.

startin Release flow control to resume stopped input.

[-]dtr Raise [drop] the DTR modem control line, unless DTR hardware flow con-
trol is selected.

[-]rts Raise [drop] the RTS modem control line, unless RTS hardware flow con-
trol is selected.

Sticky Description

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are 
beyond the range supported by the operating system. See "Fastbaud 
Data Rate Mapping" on page 46.

[-]rtspace Enable [disable] RTS hardware input flow control, so RTS drops to 
pause remote transmission.

[-]ctspace Enable [disable] CTS hardware output flow control, so local transmis-
sion pauses when CTS drops.

[-]dsrpace Enable [disable] DSR hardware output flow control, so local transmis-
sion pauses when DSR drops.

[-]dcdpace Enable [disable] DCD hardware output flow control, so local transmis-
sion pauses when DCD drops.

[-]dtrpace Enable [disable] DTR hardware input flow control, so DTR drops to 
pause remote transmission.

[-]forcedcd Disable [re-enable] carrier sense, so the TTY may be opened and used 
even when carrier is not present.

startc c

Sets the XON flow control character. The character may be given as a 
decimal, octal or hexadecimal number. Octal numbers are recognized 
by the presence of a leading zero, and hexadecimal numbers are 
denoted by a leading "0x". For example, the standard XON character, 
<CTRL-Q>, can be entered as "17" (decimal), "021" (octal) or "0x11" 
(hexadecimal).

stopc c
Sets the XOFF flow control character. The character may be given as a 
decimal, octal, or hexadecimal number (see startc, above, for format of 
octal and hexadecimal numbers).

astartc c
Sets auxiliary XON flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for for-
mat of octal and hexadecimal numbers). 

astopc c
Sets auxiliary XOFF flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for for-
mat of octal and hexadecimal numbers). 

[-]aixon
Enables auxiliary flow control, so that two unique characters are used 
for XON and XOFF. If both XOFF characters are received, transmission 
will not resume until both XON characters are received.
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Fastbaud Data Rate Mapping
Use the table below to see how setting fastbaud affects RealPort data 
rates. 

maxcps n

Sets the maximum Characters Per Second (CPS) rate at which charac-
ters are output to the transparent print device. The rate chosen should 
be just below the average print speed. If the number is too low, printer 
speed will be reduced. If the number is too high, the printer will resort to 
flow control, and user entry on the terminal will be correspondingly 
impaired. Default is 100 CPS.

maxchar n

Sets the maximum number of transparent print characters the driver 
will place in the output queue. Reducing this number increases system 
overhead; increasing this number delays operator keystroke echo 
times when the transparent printer is in use. Default is 50 characters.

bufsize n

Sets the driver’s estimate of the size of the transparent printer’s input 
buffer. After a period of inactivity, the driver bursts this many characters 
to the transparent printer before reducing to the maxcps rate selected 
above. Default is 100 characters.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: "\033[5i".

term t

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminals: 
adm31, ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, 
pcterm, tvi, vp-a2, vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, 
or wyse75. If the terminal type is not found in the internal default table, 
then ditty reads the terminfo entry for the terminal type and sets trans-
parent print on/off strings to values given by the mc5/mc4 attributes 
found there.

Specified Data Rate: Data Rate Mapped to:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800

Sticky Description
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Troubleshooting RealPort in SCO OpenServer 5: 

If none of the ports work:
1. Check the Status of the RealPort Daemon:

From the UNIX root prompt, type: 
ps -ef | grep drpd

You should see an entry for each Digi device similar to the following, please verify the 
respective IP address.

‰–q 1027 199.86.5.1

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit. If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

2. To restart the daemon type the following from the UNIX root prompt: 
#  drpadmin

3. Select ‘r’ to reset, followed by the item number for the entry to reset.

If some of the ports do not work:
1. Check serial signal activity:

Check the serial signals by typing “display port range=[port_number]” from 
the Device root prompt.  For a graphical utility to display port signals, 
please download and install DPA Remote. Go to http://www.digi.com/
support and enter your device and OS then search for DPA Remote.
If the OFC or IFC signals are solid, this would indicate either an output 
buffer overflow (OFC) or an input buffer overflow (IFC).  Sometimes, 
issuing the following command from the UNIX root prompt can clear the 
port:

# ditty startin startout flush ttyx##

2. If this command does not work, a reboot of the UNIX server may be 
required to clear the port from an overflow condition.

3. Kill any active processes:

To kill any active processes, which may be stuck on the UNIX host, please 
issue the following commands from the root prompt:

# fuser –k /dev/ttyx##

Where ttyx## represents the actual tty id.
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Requirements and Considerations
Read this section before beginning the RealPort driver installation.

• "SVR4" in this section refers to versions of Unix System V Release 4 
including SCO UnixWare. 

• Installing the RealPort software on an SVR4 Unix host where a 
RealPort driver prior to version 4.0 has already been installed will 
delete the existing RealPort configuration. You will have to re-enter 
the configuration. Installing over an installation of RealPort version 
4.0 or later will retain the existing configuration. 

• Encrypted RealPort is a security measure to maintain data integrity. 
In other words, prevent unauthorized changes in data including 
intentional destruction or alteration, tampering, duplication, or 
accidental loss. Encrypted RealPort also prevents disclosure to 
unauthorized individuals or processes. If your data is sensitive, 
Encrypted RealPort is strongly recommended. 

Information to Gather
Before you install RealPort, determine the following

• The hostname or IP address to assign each unconfigured Digi 
device.

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 

• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Master Setup Process
Use this process to install and configure the SCO UnixWare RealPort 
driver.
1. Read any release notes that may be included with the installation 

media. 

2. Gather information necessary for installation. See "Information to 
Gather" on page 48.

3. Install the RealPort driver. See one of the following:

• "Installing the Driver (Including Encrypted RealPort): CD" on page 
49

• "Installing the Driver: Downloaded Using pkgadd" on page 49.
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4. Add a device. See"Adding a Digi Device" on page 50

5. Configure the Digi device for RealPort. See one of the following:

• "Configuring the Digi Device for RealPort" on page 50

See "EtherLite RealPort Installation" on page 128 for configuring RealPort on an 
Etherlite device or "Digi CM RealPort Installation" on page 136 for configuring RealPort 
on a Digi CM device.

• "Master Setup Process" on page 48.

Installing the Driver (Including Encrypted RealPort): CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.
1. Choose an operating system. 

2. Choose the Hardware product name. 

3. Choose the software or driver you wish to install. 

4. Choose Install Software. 
Note: Follow the prompts. You will be prompted with the following to install 

Encrypted RealPort: 

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always

The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y

5. Confirm your configuration.

6. Reboot your system if necessary. 

Installing the Driver: Downloaded Using pkgadd
Use this procedure to install a downloaded driver. 

1. Download the appropriate driver file(s). 
49 Chapter 6   SCO UnixWare RealPort Installation 



2. Log in as root on the UNIX system. 

3. Enter this command at a root prompt:
pkgadd -d /path/filename 

where path/filename are the path to the driver file and the name of the driver file.

4. Follow the system prompts to install the driver. 

Installing the Driver: Downloaded Using SCO Admin
1. Download the driver from the Digi web site.

2. Log into the system as root.

3. Format a diskette.  

4. Access the root prompt.

5. Copy the driver to the formatted diskette.

6. Insert the newly-created driver diskette. 

7. Do one of the following:

• In thw window environment, select <SCO Admin> 

• At the root prompt, type scoadmin.

8. Double-click the Software Management folder in the System 
Administration window. 

9. Double-click <Application Installer>. 

10.Choose <Disk_A> from the Install from: menu. 

11. Choose <Update View>. 

12.Choose the Digi driver to install. 

13.Choose <Install>. 

14.Follow the system prompts to install the driver.

Adding a Digi Device 
1. Log in at root prompt

2. Enter:
ncxa_config

3. From the configuration menu select Add a unit.

4. Select Save Configuration, Install, and Quit.

Configuring  the Digi Device for RealPort
Use this procedure to configure the Digi device for use with Digi RealPort 
drivers. See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on page 
136 for configuring RealPort on a Digi CM device.

Note: See the appropriate Command Reference or Configuration and 
Administration Guide for more information on the commands that follow.
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1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 

3. Verify that the RealPort TCP port number is set to 771. Change if 
necessary.

4. For all ports that will be using RealPort, set the device type to rp. The 
following example configures port for RealPort: 

set ports range=1 dev=rp

Uninstalling RealPort
Use this procedure to uninstall the RealPort driver.

Note: The pkgrm utility will remove all RealPort files, including the configuration file, 
/etc/realport.conf. To reinstall the RealPort driver you will need to re-enter the 
configuration or restore realport.conf from a backup.

Note: To stop RealPort devices temporarily, use realport_stop and then 
realport_start to restart them. To remove the RealPort driver from the 
kernel temporarily, use realport_uninstall and then realport_install to re-install the 
driver in the kernel. In both cases the configuration information will be 
retained. For more information on realport_stop, realport_start, 
realport_uninstall, and realport_install, consult the UNIX man pages.

1. Enter the following command at a root prompt: 
pkgrm ncxa

2. Follow the subsequent prompts. 
You should receive a message reporting a successful removal. If any 
problem or error occurs during the execution of the pkgrm command, 
reboot the system and try repeating the command.

General SCO UnixWare Device Configuration
Use this information to configure serial ports, which includes configuring 
port direction (incoming and outgoing), transmission speed, and other port 
attributes.
1. Start the SCO Serial Manager by entering this command at a SCO 

UnixWare command prompt: 
scoadmin serial

2. Choose View and change the selection from Ports to Boards. 

3. Choose the ncxa daemon for Digi RealPort. 

4. Choose View and change from Boards to Ports. The ports will be listed. 

5. Configure the ports as needed. Use the SCO UnixWare online help for 
additional information. 

6. Exit the SCO Serial Manager. 
Note: There is a bug in the SCO UnixWare Serial Manager that causes it to 

incorrectly set the "o" and "P" ttymon flags for a RealPort modem port. If the 
port does not work for logins, you may need to remove these flags. Use the 
realport_pm_flags program to list all non-console ttymon port monitor flags 
and change them appropriately.
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General SVR4 Device Configuration
This topic describes how to configure serial ports, which includes 
configuring port direction (incoming and outgoing), transmission speed, 
and other port attributes.

Enabling Login on a Port
1. At a UNIX command prompt, enter the following command:

sysadm 

2. Choose Ports > Quick Terminal > Add. 

3. Follow the remaining sysadm prompts. 

4. Repeat these steps for every port to be enabled. 

5. Exit sysadm. 

Modifying Port Settings
1. At a UNIX command prompt, enter the following command:

sysadm 

2. Choose Ports > Ports Services > Modify. 

3. Follow the remaining sysadm prompts. 

4. Change the port parameters as needed. 

5. Repeat these steps for every port. 

6. Exit sysadm. 

Configuring a Device for a Terminal
Use this information to configure serial ports, which includes configuring 
port direction (incoming and outgoing), transmission speed, and other port 
attributes.

1. Start the SCO Serial Manager by entering this command at a SCO 
UnixWare command prompt: 

scoadmin serial

2. Choose View and change the selection from Ports to Boards. 

3. Choose the ncxa daemon for Digi RealPort. 

4. Choose View and change from Boards to Ports. The ports will be listed. 

5. Configure the ports as needed. Use the SCO UnixWare online help for 
additional information. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

6. Exit the SCO Serial Manager. 
Note: There is a bug in the SCO UnixWare Serial Manager that causes it to 

incorrectly set the "o" and "P" ttymon flags for a RealPort modem port. If the 
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port does not work for logins, you may need to remove these flags. Use the 
realport_pm_flags program to list all non-console ttymon port monitor flags 
and change them appropriately.

Configuring a Device for a Modem
Use this procedure to configure a RealPort device for a Dial-in/Dial-out 
modem connection. Configuring a device for a modem requires familiarity 
with both the operating system and the modem being used. While the 
following procedure is sufficient for most cases, it may be necessary to 
take additional steps to properly configure your modem or to set up the 
operating system for a specific application.
The Digi device should be properly installed, configured and functioning 
before proceeding.

1. Connect a proper cable between the port and modem. 

2. Disable both the modem and non-modem control ports. This can be 
done through sysadm. SCO UnixWare users can enable and disable 
ports through scoadmin>Hardware>Serial Manager. 

3. Modify the file /usr/lib/uucp/Devices. Create an entry that looks like this: 
Direct term/a01m,M - 38400 direct_modem

The device ttya01m used here is just an example.
Comment out any ACU lines relating to this device until dial-in is working properly.
An ACU line is necessary for correct operation of the modem in dial-out applications. 
Refer to the modem manual or to the modem manufacturer for the correct modem ini-
tialization string to use for your modem. Refer to the SCO UnixWare Administration 
handbook for guidance on setting up an appropriate ACU entry that uses this initializa-
tion string.

4. Connect to the modem by entering this command at a Unix root prompt: 
cu -l /dev/term/a01m -s 38400

It may be necessary to use a01s instead:
cu -l /dev/term/a01s -s 38400

5. Train the modem to the port speed with this at command: 
at&w

6. Depending on the modem, it may be necessary to enable auto-answer 
with this at command: 

ats0=1&w

7. Disconnect from the modem by entering tilde-period. 
~.

8. Enable and configure the port using the SCO Serial Manager, scoadmin.

Configuring a Device for a Printer
Use this procedure to configure a RealPort device for a printer. See your 
operating system documentation for more information on configuring a 
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serial device for a printer and configuring an lp device.
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding.
If you are using a printer attached to a terminal on a RealPort, use the 
corresponding RealPort transparent print device. For example, if your 
terminal is on /dev/term/a01s then the attached printer would be on /dev/
pra01s.

1. Connect a proper cable between the port and printer. 

2. Insert either of following commands at the end of the file /etc/rc2.d/
S99printer: 

cat < /dev/term/a01s > /dev/null &

or
sleep 999999 < /dev/term/a01s &

These commands force the specified port to stay open, thus preserving any "non-
sticky" options. This example uses the port /dev/term/a01s. Substitute your port name 
in the command.
The file S99printer is just an example. This file may need to be created. An "S99" file 
with a different name may be used instead.

3. Insert any other necessary ditty commands at the end of the file 
/etc/rc2.d/S99printer. The command ditty can be used to change the 
settings of a port. For additional information on ditty, see "Setting TTY 
Options" on page 55. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

For example, the following command will set the port a01s to a speed of 
38400, disable software flow control, and enable hardware flow control 
on the port:

ditty 38400 -ixon -ixany -ixoff ctspace a01s

Note: The Data Carrier Detect (DCD) signal needs to be active (high) on the port for 
the port to function properly for a printer. The ditty forcedcd option can be 
used to accomplish this when the DCD signal is not made active through 
cabling.

4. If you are configuring a transparent print device, add ditty commands to 
set the transparent print parameters. See "Transparent Printer Setup" on 
page 58, for more information. 

5. For the ditty command to take effect immediately, enter the command 
manually at a system root prompt, or reboot the system. 

6. Configure the device as a printer by running scoadmin printer. 

7. The printer should be ready for use. To print a file, use the command 
lp -d printer_name file_to_print

where printer_name is replaced with the name given to the printer in sysadm or scoad-
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min, and file_to_print is replaced with the name of the file to print.

Setting TTY Options

Introduction
RealPort UNIX device driver packages include a command, ditty  , which is 
a superset of stty, and may be used to set and display the device options 
for Digi RealPort devices. Commands may be executed from the command 
line or placed in a startup script to be run whenever the system is booted. 
Any unrecognized options are passed to stty for interpretation.

Syntax
The following is the ditty command format:
ditty [-a] [{-n ttyname | ttyname}] [option]

Descriptions

ditty (without additional fields)
Displays all Digi special driver settings and all standard settings for all 
TTYs 

-a
Displays all unique Digi option settings and standard TTY settings 
reported by stty -a

{-n tyyname | tyyname}
Alternate ways of displaying and displays options for the given TTY 
device, instead of standard input. This option may be specified multiple 
times to perform the same operation on multiple TTYs.
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Options

Option Description

aixon | -aixon

aixon enables auxiliary flow control, so that two unique char-
acters are used for XON and XOFF. If both XOFF characters 
are received, transmission will not resume until both XON 
characters are received. -aixon disables this feature. When 
the system reboots, this parameter reverts to the default set-
ting.

astart c
Sets the auxiliary XON flow control character. The character 
may be a decimal, octal, or hexadecimal number.  When the 
system reboots, this parameter reverts to the default setting.

astop c
Sets the auxiliary XOFF flow control character. The character 
may be a decimal, octal, or hexadecimal number.  When the 
system reboots, this parameter reverts to the default setting.

break Send a 250 MS break signal out on the TTY line.

bufsize n

Sets the driver’s estimate of the size of the transparent 
printer’s input buffer. After a period of inactivity, the driver 
bursts this many characters to the transparent printer before 
reducing to the maxcps rate selected above. Default is 100 
characters.

clear

Clears the tbusy flag in the channel structure to free a port. ?? 
What does this mean and HTML says applies to Xem and Cx, 
and then only to Unixware, openserver and solaris. What 
gives??

ctspace | -ctspace
ctspace enables CTS hardware input flow control. -ctspace 
disables it. When the system reboots, this parameter reverts 
to the default setting.

dcdpace | -dcdpace
dcdpace enables DCD hardware output flow control, and -
dcdpace disables it. When the system reboots, this parameter 
reverts to the default setting.

dsrpace | -dsrpace
dsrpace enables DSR hardware output flow control, and -dsr-
pace disables it. When the system reboots, this parameter 
reverts to the default setting.

dtr | -dtr

dtr raises the DTR modem control line, and -dtr lowers it. 
These options work only when DTR hardware flow control is 
not configured. When the device is closed, this parameter 
reverts to the default setting.

dtrpace | - dtrpace
dtrpace enables DTR hardware input flow control, and -dtr-
pace disables it. When the system reboots, this parameter 
reverts to the default setting.

fastbaud | -fastbaud ???? When the system reboots, this parameter reverts to the 
default setting. 

forcedcd | -forcedcd
forcedcd raises the DCD signal, and -forcedcd lowers it. 
When the system reboots, this parameter reverts to the 
default setting.

flush Immediately discards input and output to and from the device.

flushin Immediately discards input to the device

flushout Immediately discards device output
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maxchar n

Sets the maximum number of transparent print characters the 
driver will place in the output queue. Reducing this number 
increases system overhead; increasing this number delays 
operator keystroke echo times when the transparent printer is 
in use. Default is 50 characters. When the system reboots, 
this parameter reverts to the default setting.

maxcps n

Sets the maximum Characters Per Second (CPS) rate at 
which characters are output to the transparent print device. 
The rate chosen should be just below the average print 
speed. If the number is too low, printer speed will be reduced. 
If the number is too high, the printer will resort to flow control, 
and user entry on the terminal will be correspondingly 
impaired. Default is 100 CPS. When the system reboots, this 
parameter reverts to the default setting. 

offstr “s”

Defines the terminal escape sequence to stop directing data 
to the printer. 
s is a string of ASCII characters, enclosed in quotation marks, 
that command the terminal to enter transparent printing 
mode. An arbitrary octal character xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i". When the system reboots, this parameter reverts 
to the default setting.

onstr “s”

Defines the terminal escape sequence to direct subsequent 
data to the transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that 
command the terminal to enter transparent printing mode. An 
arbitrary octal character xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i". When the system reboots, this parameter 
reverts to the default setting.

rts | -rts

rts raises the RTS modem control line, and -rts lowers it. 
These options work only when RTS hardware flow control is 
not configured. When the device is closed, this parameter 
reverts to the default setting.

rtspace | -rtspace
rtspace drops RTS to enable RTS input flow control. -rtspace 
raises RTS to resume input. When the system reboots, this 
parameter reverts to the default setting.

start c

Sets the XON flow control character. The character may be 
given as a decimal, octal or hexadecimal number. Octal num-
bers are recognized by the presence of a leading zero, and 
hexadecimal numbers are denoted by a leading "0x". For 
example, the standard XON character, <CTRL-Q>, can be 
entered as "17" (decimal), "021" (octal) or "0x11" (hexadeci-
mal). When the system reboots, this parameter reverts to the 
default setting.

startin
Enables input to begin again after it has been stopped by the 
stopin option. When the device is closed, this parameter 
reverts to the default setting. 

startout
Enables output to begin again after it has been stopped by the 
stopout option. When the device is closed, this parameter 
reverts to the default setting.

Option Description
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Fastbaud Data Rates
Use the table below to see how fastbaud data rates affect RealPort data 
rates. 

Transparent Printer Setup

About Transparent Printing
Most terminals have an auxiliary port that can be connected to a serial 
printer. When this port is configured as a transparent printer port, print jobs 
may be run simultaneously with normal terminal operation.
Data bound for the printer is preceded by a terminal escape sequence 
which turns on transparent printing, and followed by a sequence which 
turns transparent printing off.
Set up a transparent printer in the same way you would set up a printer 
wired directly to a serial port. Data sent to a transparent printer device is 

stop c 

Sets the XOFF flow control character.The character may be 
given as a decimal, octal or hexadecimal number. Octal num-
bers are recognized by the presence of a leading zero, and 
hexadecimal numbers are denoted by a leading "0x". When 
the system reboots, this parameter reverts to the default set-
ting.

stopin Stops input to the device. When the device is closed, this 
parameter reverts to the default setting.

stopout Stops output from the device. When the device is closed, this 
parameter reverts to the default setting.

term t

Sets the transparent printer on/off strings to values found in 
the internal default table. Internal defaults are used for the fol-
lowing terminals: adm31, ansi, dg200, dg210, hz1500, mc5, 
microterm, multiterm, pcterm, tvi, vp-a2, vp-60, vt52, vt100, 
vt220, wyse30, wyse50, wyse60, or wyse75. If the terminal 
type is not found in the internal default table, then ditty reads 
the terminfo entry for the terminal type and sets transparent 
print on/off strings to values given by the mc5/mc4 attributes 
found there. When the system reboots, this parameter reverts 
to the default setting.

Specified Data Rate: Data Rate Mapped to:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800

Option Description
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automatically "wrapped" in the transparent print on/off command strings for 
the specified printer.

Configuring Transparent Printers
Use this procedure to set up transparent printers on terminals. 

Note: This procedure sets up the communication characteristics for transparent 
printers. Once a transparent printer has been set up, you can use it as you 
would a printer connected directly to a serial port. See your UNIX 
documentation for information on setting up print queues.

Procedure

At the command prompt, enter:
ditty -n ttyname [options]

where ttyname is the name of the terminal device and options are selected from the list 
below.

Note: Depending on your operating system, the ditty program may be named 
differently. See "Setting TTY Options" on page 55, for the correct command 
line format for your operating system.

maxcps 
n 

Limits the maximum printer port character-per-second data rate. n should 
be set to the minimum character rate the printer can sustain in typical 
use.

maxchar 
n 

Limits the number of characters queued to the printer ahead of terminal 
output. Lower numbers increase system overhead, higher numbers result 
in keystroke echo delays. A value of 50 is generally a good compromise 
at 9600 baud.

bufsize n 

This parameter should be set to a value just below the printer's buffer 
size. After a period of inactivity, the driver will burst up to this many char-
acters to the printer to fill the print buffer before slowing to the maxcps 
rate.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[5i" would be entered as: "\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[4i" would be entered as: "\033[4i".

term t 

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminal types: 
adm31, ansi, dg200, dg210, hz1500, mc5, vt100, vt220, vt320, vt420, 
wang2x36, wyse30, wyse50, wyse60 or wyse75.
If the terminal type is not found in the internal default table, then ditty 
reads the terminfo entry for the terminal type and sets the transparent 
print on/off strings to the values given by the mc5/mc4 attributes found 
there.
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Troubleshooting RealPort in SCO UnixWare 7: 

If none of the Ports work:
1. Check the Status of the RealPort Daemon:

From the UNIX root prompt, type: 
ps -ef | grep ncxd

You should see an entry for each Digi device similar to the following, please verify the 
respective IP address.

root 2254 1 TS 80 0 Dec 13 ? 0:00/usr/sbin/ncxd /dev/ncxa/net1 
192.168.2.2

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit. If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

2. To restart the daemon type the following from the UNIX root prompt: 
#  ps –ef | grep ncxd

#  kill –9 (PID)

Where PID equals the process identification number returned from the ps –ef command.
#  /etc/idrc.d/ncxa

If some of the ports work:
1. Check serial signal activity:

Check the serial signals by typing “display port range=[port_number]” from 
the Device root prompt.  For a graphical utility to display port signals, 
please download and install DPA Remote. Go to
http://www.digi.com/support and enter your device and Operating system 
then search DPA Remote.
If the OFC or IFC signals are solid, this would indicate either an output 
buffer overflow (OFC) or an input buffer overflow (IFC).  Sometimes, 
issuing the following command from the UNIX root prompt can clear the 
port:

# ditty startin startout flush ttyx##

2. If this command does not work, a reboot of the UNIX server may be 
required to clear the port from an overflow condition.

3. Kill any active processes:

To kill any active processes, which may be stuck on the UNIX host, please 
issue the following commands from the root prompt:

# fuser –k /dev/ttyx##

Where ttyx## represents the actual tty id.
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Requirements and Considerations
Read this section before beginning the RealPort driver installation.

• To determine if a particular version of the Linux RealPort driver 
supports a particular version of Linux, check the release notes for 
that driver.

• RealPort utilities are located in /usr/bin/dgrp.

• Once the RealPort driver is installed, man pages are available for a 
number of the utilities associated with the package, including:

Information to Gather
Before you install RealPort, you need to determine:

• The hostname or IP address to assign each unconfigured Digi 
device. 

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 

• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Configuring the Digi Device for RealPort
Use this procedure to configure the Digi device for use with Digi RealPort 
drivers. See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on page 
136 for configuring RealPort on a Digi CM device.

Note: See the appropriate Command Reference or Configuration and 
Administration Guide for information on how to perform the steps below.

Procedure
1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 

3. Verify that the RealPort TCP port number is set to 771. Change if 
necessary.

Chapter 7 L I N U X  R e a l P o r t  I n s t a l l a t i o n

ditty-rp which sets and displays RealPort TTY device options 

dgrp_cfg_node a tool used to add and remove Digi devices from the RealPort 
driver

drpd the Digi RealPort network daemon

dgrp.o
the RealPort driver module. These are placed in /usr/bin/dgrp. 
The actual man page entry associated with the drgp.o module 
is dgrp. 

dgrp_gui the Digi RealPort Manager for x-windows
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4. For all ports that will be using RealPort, set the device type to rp. The 
following example configures ports 2 through 16 of a PortServer for 
RealPort: 

set ports range=2-16 dev=rp

Master Setup Process
Use this process to install and configure the Linux RealPort driver.
1. Read any release notes that may be included with the installation 

media.

2. Gather information necessary for installation. See "Information to 
Gather" on page 62. 

3. Install the RealPort driver. See Installing the Driver: Introduction, below.

4. Configure the PortServer for RealPort. See:

• "Configuring the Digi Device for RealPort" on page 62

• "Master Setup Process" on page 63

5. Add and configure your Digi device in Linux. There are two methods for 
doing this. See: 

• "Managing a Digi Device with Digi RealPort Manager" on page 71 

• "Managing a Digi Device with dgrp_cfg_node" on page 74 

Note: Digi RealPort Manager uses a graphical interface, while dgrp_cfg_node is 
command line-based.

6. Configure your ports for operation. See "Device Configuration 
Overview" on page 77.

RealPort Driver Configuration: Introduction
Digi Supports four distribution methods for the RealPort device driver 
package.

CD Method

Use this procedure to install a Digi driver from the Digi CD front end menu. 
This procedure assumes that you have accessed the Digi RealPort CD and 
that the front end menu appears on your screen. see "Installing the Driver 
(Including Encrypted RealPort): CD" on page 64.

Digi Connect CD

Follow the instructions for the RPM method or TGZ method if your LINUX 
distribution does not support RPM installation

RPM Method

This method uses a source RPM package. The source RPM method 
depends on rpm tools. If your Linux distribution does not support RPM 
packages, or if your system does not have the RPM tools installed, you 
must either locate and install the RPM manipulation tools or use the TGZ 
method. To install with this method, see "Installing the Driver: RPM 
Methods" on page 64.

Note: Digi does not support the distribution of the RealPort software via binary 
RPMs.
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TGZ Method

This method uses a compressed archive of the source. The TGZ method, 
while relatively simple, does not have the advantage of the common 
package management operations of RPM-based packages. It does, 
however, have the advantage that far more systems will support the TGZ 
method “out-of-the-box”. To install with this method, see"Installing the 
Driver: TGZ Method" on page 68.

Installing the Driver (Including Encrypted RealPort): CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.

Procedure
1. Choose an operating system. 

2. Choose the Hardware product name. 

3. Choose the software or driver you wish to install. 

4. Choose Install Software. 

5. Follow the prompts. 

6. Confirm your configuration.

7. Reboot your system if necessary. 

Installing the Driver: RPM Methods
Use one of the following procedures to install the Linux RealPort driver.

Note: The procedures in this topic should be used only in Linux environments that 
support the installation and building of packages from an RPM repository. The 
procedures require that the following RPM directories exist and are used by 
RPM on your Linux system.

• /usr/src/redhat/BUILD

• /usr/src/redhat/RPMS

• /usr/src/redhat/RPMS

• /usr/src/redhat/SOURCES

• /usr/src/redhat/SPECS

• /usr/src/redhat/SRPMS
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Installation Methods

There are two methods of installing with RPM: 

Both methods are discussed in detail on the pages that follow.

Package Version and Revision

Certain commands used in the following procedures need to be entered 
with the correct package version and revision number.

Note: To determine package version and revision numbers, use this command:

rpm -qp filename

Example: 

If the package version of the Linux driver is 1.0 and the revision is 2, then:

Standard Installation Procedure
Use this procedure to install the RealPort Linux driver. See Package 
Version and Revision, above, for important information on entering 
commands in this procedure. See also README notes for additional 
information.
1. Download the source RPM package. The RPM package can be found 

on Digi's web site, http://www.digi.com/support. For consistency, you 
might consider downloading the source RPM to the directory /usr/src/
redhat/SRPMS. 

2. Install the source code in the SOURCES directory used by RPM 
(/usr/src/redhat/SOURCES) with this command: 

rpm -ivv dgrp-version-revision.src.rpm

This command also copies the specification file 
(/usr/src/redhat/SPECS/dgrp-v.v.spec) to the SPECS directory.

Method Description

Standard 
Installation 
Procedure

This method is still automated but there is user control at every 
step.

Custom 
Installation 
Procedure

This method is intended for use by users who wish to customize 
the installation (for example, to change the destination directories 
of certain tools). This method is the most complex and should be 
used only if necessary.

For this command variable: This value would be used:

version 1.0

revision 2

For this command: ******This would be entered:

rpm -ivv dgrp-version revision.src.rpm rpm -ivv dgrp-1.0-2.src.rpm
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LINUX OS Versions

3. Create an RPM specific to your platform by executing the following 
commands:

cd /usr/src/redhat/SPECS

rpmbuild --rebuild --define DISTRO=REDHAT_XX  (package)

rpm -ivv /usr/src/redhat/RPMS/i386/dgrp-#.#-#.i386.rpm

insmod dgrp

(RPM example is Red Hat. Use the previous table for the correct command)

4. Install the RPM which was just created by the previous step using the 
following commands. 

cd /usr/src/redhat/RPMS/arch
rpm -ivv dgrp-version-revision.arch.rpm

The arch value should be replaced with a string representing your architecture, such as 
i386 or alpha. This value is system dependent, and is chosen by your system when the 
RPM is built.

OS Version Commands

Red Hat

#  rpmbuild --rebuild --define DISTRO=REDHAT_XX  (package)
#  rpm -ivv /usr/src/redhat/RPMS/i386/dgrp-#.#-#.i386.rpm
#  insmod dgrp

Note: Actual DISTRO Values:

 Red Hat AS/ES/WS 2.1 = REDHAT_21 

 Red Hat AS/ES/WS 3.0 = REDHAT_ES3 

 Red Hat Fedora Core 1,2, or 3 = FEDORA  

 Red Hat 9.0 = REDHAT_90 

 Red Hat 8.0 = REDHAT_80 

 Red Hat 7.3 = REDHAT_73 

 Red Hat 7.2 = REDHAT_72  

Note: There is no DISTRO flag required for Red Hat AS/ES/WS 4

SuSE 8.x

#  rpm --rebuild (package)
#  rpm -i /usr/src/packages/RPMS/i586/dgrp-#.#-#.i586.rpm
#  insmod dgrp

SuSE 9.x

#  rpmbuild --rebuild (package)
#  rpm -i /usr/src/packages/RPMS/i586/dgrp-#.#-#.i586.rpm
#  insmod dgrp

Mandrake

#  rpmbuild --rebuild (package)
#  rpm -i /usr/src/RPM/RPMS/i586/dgrp-#.#-#.i586.rpm
#  insmod dgrp 

Debian

#  rpmbuild --rebuild (package)
# cd /usr/src/rpm/RPMS/i386 
# alien -d dgrp-#.#-#.i386.rpm 
# dpkg -i dgrp_#.#-#_i386.deb
# insmod dgrp
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Note: To install the RealPort driver on another system of the same architecture and 
Linux version, copy the following binary to the same location on the other 
system and execute the rpm command in this step:

/usr/src/redhat/RPMS/arch/dgrp-version-revision.arch.rpm

5. Use the following commands to verify that all files are installed 
correctly: 

cd /usr/src/redhat/SPECS
rpm -bl dgrp-version.spec

Custom Installation Procedure

Important: This custom installation procedure is reserved for those users that need to 
change a portion of the installation procedure or its contents in their specific environment. 
Reasons might include a need to change the directory where files are installed, or to 
modify the source code. Modifications to the source package may cause Digi to 
refuse support for that package in that environment.
See "Package Version and Revision" on page 65, for important information on entering 
commands in this procedure.

1. Download the RPM package. The RPM package can be found on Digi's 
web site, http://www.digi.com/support. For consistency, you might 
consider downloading the source RPM to the directory /usr/src/redhat/
SRPMS. 

2. Install the source code in the SOURCES directory used by RPM (/usr/
src/redhat/SOURCES) with this command: 

rpm -ivv dgrp-version-revision.src.rpm

This command also copies the specification file (/usr/src/redhat/SPECS/dgrp-
version.spec) to the SPECS directory.

3. Use the RPM tools to open the source archive: 
cd /usr/src/redhat/SPECS
rpm -bp dgrp-version.spec

The -bp option specifies that only the preparation section (%prep) of the specification file 
should be executed. This might result in the source files being uncompressed, removed 
from the archive, and placed in the following directory:

/usr/src/redhat/BUILD/dgrp-version

4. Make desired modifications to the source files and/or the specification 
file. The source files are found in the directory 

/usr/src/redhat/BUILD/dgrp-version

The specification file is named:
/usr/src/redhat/SPECS/dgrp-version.spec

Important: You should save the original version of any file that you change, plus the 
final version of the files after you make and test your changes. These backup copies 
should be placed somewhere other than in the /usr/src/redhat tree.

Important: If you change the final location of any of the files in the package, you must 
also update the %file list in the specification file. Otherwise, you will get a message that 
the installation was incomplete, because some files were not found.

Recommended: It is recommended that you document your changes in the 
%description section of the specification file.
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5. The easiest method for building and installing the modified package is 
to first replace the Digi TGZ archive with a new one including your 
changes. Replace the archive by doing the following: 

a. Change to the appropriate directory: 

cd /usr/src/redhat/BUILD

b. Create a compressed archive of the source files: (note that the following command 
should be entered on a single line) 

tar -cvzf ../SOURCES/dgrp-version.tgz dgrp-version/*

Once the TGZ file has been replaced, you can proceed with step 3 of the "Standard 
Installation Procedure" on page 65.

Installing the Driver: TGZ Method 
The following procedure can be used in any Linux environment. It is the 
only choice available for environments which do not support RPM.

Package Version and Revision

Certain commands used in the following procedure need to be entered with 
the correct package version and revision number.

Note: Refer to release notes for version and revision (release) numbers.

Procedure
1. Download the Linux RealPort TGZ file. This file can be found on Digi's 

web site, http://www.digi.com/support. 

2. Choose a directory (such as /usr/src) where the source tree will reside, 
and unpack the compressed archive file there. For example: 

cd /usr/src
tar -xvzf dgrp-version-revision.tgz

This will create a subdirectory called dgrp-version containing all of the RealPort source 
files.

3. Change directory to the root of the source directory tree. 
cd /usr/src/dgrp-version

4. Create Makefile script
./configure

Note: Occasionally, a Linux Vendor will ship a kernel that simply cannot
be autodetected to add the various changes that might be required
for that specific kernel.
Because of this, there is an option that can be used for both the
srpm and tgz to tell the driver package exactly what distribution
you have.Currently, the recognized options are for:
Red Hat 7.2 - REDHAT_72,
Red Hat 7.3 - REDHAT_73,
Red Hat 8.0 - REDHAT_80,
Red Hat 9.0 - REDHAT_90,
Red Hat Fedora Core 1,2, or 3 - FEDORA,
Red Hat AS/ES/WS 2.1 - REDHAT_AS_21, REDHAT_ES_21, 

For this command: This would be entered:

tar -xvzf dgrp-version revision.tgz tar -xzvf dgrp-1.0-2.tgz
Chapter 7  LINUX RealPort Installation  68



REDHAT_WS_21
Red Hat AS/ES/WS 3.0 - REDHAT_AS_3 / REDHAT_ES_3 / REDHAT_WS_3 

For example, to tell the srpm that you have Red Hat 9, run this command instead:
* rpmbuild --rebuild --define DISTRO=REDHAT_9 DRIVER_PACKAGE_NAME.srpm

To tell the tgz that you have Red Hat AS 3, run this during the"configure" phase:
* ./configure DISTRO=REDHAT_AS_3

5. Examine the Makefile and make modifications as required by your 
system environment. Common items to check would include 
destinations directories, naming conventions, and compiler details. 

6. When satisfied with the state of the Makefile and other source files, 
compile the driver and its support tools by entering this command: 

make all

7. Install the package components with:
make install

8. Register your module with the system initialization scripts by entering:
make postinstall

Recommended: Do not delete the source tree since the makefiles are necessary for the 
uninstall procedure.

Uninstalling the Driver
Use one of the following methods to uninstall the Linux driver.

Uninstalling with RPM
Note: The procedures in this topic should be used only in Linux environments which 

support the installation and building of packages from an RPM repository. The 
procedures require that the following RPM directories exist and are used by 
RPM on your Linux system:

• /usr/src/redhat/BUILD

• /usr/src/redhat/RPMS

• /usr/src/redhat/SOURCES

• /usr/src/redhat/SPECS

• /usr/src/redhat/SRPMS

Procedure
1. Use the dgrp_cfg_node command with the uninit option for each 

PortServer. This will kill each PortServer daemon and erase all 
information of that PortServer from the system. 

dgrp_cfg_node uninit ID

where ID specifies the ID of the PortServer to unconfigure.

2. Enter this command to remove the driver package:
rpm -e -vv dgrp-version

Uninstalling from a TGZ Archive
Important: If you have deleted the source repository created when you installed this 
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driver package, then there is no automated mechanism to remove the package files.

1. Access a command prompt at the root on your Linux system. 

2. Change directories to the root of the source tree 
cd /usr/src/dgrp-version

Substitute your driver version numbers for version in the previous command. For 
example, if the driver version is 1.0, the command would be:

cd /usr/src/dgrp-1.0

3. Enter these two make commands: 
make preuninstall
make uninstall

Create RealPort Devices
When installed, the Linux RealPort driver creates three different devices for 
each physical port of each Digi device: a standard TTY device, a callout 
device, and a transparent print device.

Device Naming Convention

The devices are named according to the following convention:

[prefix][ID][port]

These elements are defined as follows:

The following are examples of the devices which would be created for the 
first port of a Digi device with the RealPort ID “aa”.

Standard TTY Devices
The behavior of the standard tty devices is that of a modem controlled port. 
They require the Data Carrier Detect (DCD) signal to be high before they 
will operate. When used on a dial-in modem, the ports will wait for DCD 
before sending out the login prompt.
When these devices are used with a terminal or other locally connected 
device, it is usually the practice to wire the DCD signal to the remote 
equipment's Request To Send (RTS) line. When a terminal is then used for 

Element Description

prefix Standard TTY devices have the prefix “tty”, callout devices have the 
prefix “cu”, and transparent print devices have the prefix “pr”.

ID
The RealPort ID for the Digi device associated with this port. A 
RealPort ID consists of one or two alphanumeric characters. An 
underscore character may be used for any of the two ID characters.

port The port number must consist of two digits. The ports are numbered 
beginning with 00.

Device Type Full Path Name

Standard TTY Device /dev/ttyaa00

Callout Device /dev/cuaa00

Transparent Print Device /dev/praa00
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log-in, the system will generate a prompt when the terminal is powered-on 
(RTS, and thus DCD is asserted), and will kill the user session if the 
terminal is powered-off (lowering the signals).

Callout Devices
These devices will be obsoleted in a future version of Linux, so should 
generally be avoided. Data Carrier Detect (DCD) need not be present to 
open the device.
Once a connection is established and DCD becomes active, these devices 
behave in the same way as the standard tty devices. Subsequent loss of 
the DCD signal will cause active processes on the port to be killed.

Transparent Print Devices
The transparent print device can be used with auxiliary printer ports on 
terminals. Output to the “pr” device goes out the auxiliary port of a terminal 
while you continue to use the terminal normally.

Managing a Digi Device with Digi RealPort Manager

Introduction
Digi RealPort Manager can be used to perform these tasks. .

The Main Screen
The main screen of the Digi RealPort Manager is used to manage the Digi 
devices registered with the RealPort driver. It lists all of the currently 
configured Digi devices in the central window, and provides buttons and 
menu options to manipulate these Digi devices..

Task Procedure

Add a Digi device See "Adding a Digi Device" on page 72.

Delete a Digi device See "Deleting a Digi Device" on page 73.

Start a RealPort daemon See "Starting a RealPort Daemon" on page 73.

Stop a RealPort daemon See "Stopping a RealPort Daemon" on page 73.

Monitor port status See "Monitoring Port Status" on page 74.

Menu Field Description

RealPort ID

The RealPort ID must be one or two alphanumeric characters 
used to designate your TTY devices for RealPort. This id must be 
unique to your system. An underscore character may also be 
used for an ID character. An example for a RealPort device name 
where the letters rp are used would be: TTYrp01

address
The address may be specified as an IP number, or IP name. No 
attempt is made to validate this address, nor to connect to the 
specified address during the installation.
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Adding a Digi Device
Use this procedure to add a Digi device to your Linux System.
1. Access Digi RealPort Manager by entering this command at a Linux 

prompt: 
/usr/bin/dgrp-version/config/dgrp_gui

Note: Digi will only support use of the GUI with the wish interpreter. The wish tcl 
interpreter needs to be in the Linux "path" before the dgrp_gui command will 
work.

2. There are two ways to register a new Digi device with the RealPort 
package. Either press the Add button that appears at the bottom of the 
main screen, or choose the PortServer > Add New from the menu. In 
either case, the Digi device Settings window will appear. 

3. Specify values for each of the fields displayed (some of the fields have 
defaults). 
Note: You will be prompted to install encrypted RealPort with the following.

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always

The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y

ports

This field is an integer indicating the number of device files which 
should be created for this Digi device. This does not have to 
match the physical number of ports, but physical ports beyond 
the number specified will not be available. The maximum port 
count allowed is 64.

IP Port This is the Digi device IP port number. Normally this should be 
left at the default.

Access Mode Access Mode sets the file protection mode for any device files 
created.

Owner This field sets the user ID of the file owner for any device files 
created. The value must be an integer.

Group This field sets the group ID of the file owner for any device files 
created. The value must be an integer.

Link Speed
Link Speed sets the link speed string. The default is auto, and 
can be used under most circumstances. See the drpd(8) man 
page for information on the custom speed parameters.

Menu Field Description
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4. Press the Commit button and the RealPort Command Logger window 
will appear and an appropriate dgrp_cfg_node command will be 
displayed. 

5. Press the Run It button to execute the command and finish adding and 
initializing your Digi device. Watch for any errors in the log window. 

Deleting a Digi Device
Use this procedure to delete a Digi device from your Linux System.
1. Access Digi RealPort Manager by entering this command at a Linux 

prompt: 
/usr/bin/dgrp-version/config/dgrp_gui

Note: Digi will only support use of the GUI with the wish interpreter. The wish tcl 
interpreter needs to be in the Linux "path" before the dgrp_gui command will 
work.

2. Choose the appropriate Digi device in the list box, 

3. Press the Delete button that appears on the bottom of the main screen, 
or choose PortServer > Delete/Uninitialize from the menu. The Digi 
PortServer Settings window will appear. 

4. Confirm that the correct PortServer is being deleted and press the 
Remove button. The RealPort Command Logger window will appear 
and an appropriate dgrp_cfg_node command will be displayed. 

5. Press the Run It button to execute the command and complete the 
removal of the Digi device, along with all of its device nodes. 

Starting a RealPort Daemon
Use this procedure to start a RealPort daemon for a Digi device.
1. Access Digi RealPort Manager by entering this command at a Linux 

prompt: 
/usr/bin/dgrp-version/config/dgrp_gui

Note: Digi will only support use of the GUI with the wish interpreter. The wish tcl 
interpreter needs to be in the Linux "path" before the dgrp_gui command will 
work.

2. Choose the appropriate Digi device in the list box. 

3. Choose Daemon > Start Daemon from the menu. The Command 
Logger screen will appear and a dgrp_cfg_node command will display. 

4. Press the Run It button to execute the command and attempt to start 
the daemon. If the daemon is already running, the command will silently 
exit. 

Stopping a RealPort Daemon
Use this procedure to stop a RealPort daemon or Digi device.
1. Access Digi RealPort Manager by entering this command at a Linux 

prompt: 
/usr/bin/dgrp-version/config/dgrp_gui

Note: Digi will only support use of the GUI with the wish interpreter. The wish tcl 
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interpreter needs to be in the Linux "path" before the dgrp_gui command will 
work.

2. Choose the appropriate Digi device in the list box. 

3. Choose the Daemon > Stop Daemon from the menu. The Command 
Logger screen will appear and a dgrp_cfg_node command will display. 

4. Press the Run It button to execute the command and attempt to stop 
the daemon. If the daemon is not running, the command will silently 
exit. 

Monitoring Port Status
When monitoring ports, you can change the port monitoring delay by using 
the sliding scale along the bottom of the Ports window. Modem signal 
values are only correct for open ports. Ports in the closed or waiting state 
may not display the correct modem signals. When monitoring ports, the 
Refresh button may be selected at any time to update the port fields. Use 
the following procedure to monitor the status of a RealPort port. 

Procedure
1. Access Digi RealPort Manager by entering this command at a Linux 

prompt: 
/usr/bin/dgrp-version/config/dgrp_gui

Note: Digi will only support use of the GUI with the wish interpreter. The wish tcl 
interpreter needs to be in the Linux "path" before the dgrp_gui command will 
work.

2. Choose the appropriate Digi device in the list box. 

3. Choose the Ports option of the View menu. 

4. Choose the appropriate port in the Ports Window. 

5. Press either the Modem Status button or select the Modem Status 
option of the Ports menu. The Port Status window will appear. A signal 
will show a red box if it is active or a gray box if it is inactive. 

Ports Window Information
These are the fields of the Ports Window:

Managing a Digi Device with dgrp_cfg_node
The dgrp_cfg_node tool is a command-line based configuration program 

Field Description

Port Port is the port number of an individual port. The first port on a 
Digi device is port number 0.

Status

The value of this field is either open, closed, or waiting. A port 
moves into the waiting state when there are devices waiting to 
open the port (either waiting for an event, or for another process 
to release the port).

Speed
This value is the last known speed (in bps) of the port. If unknown 
(for instance, before the port is used for the first time), the value 0 
is shown. 

Description This field is not yet active and will always show NA
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designed to automate a number of steps which are required in order to 
enable the serial ports on Digi devices for general use. The path to the 
dgrp_cfg_node executable is /usr/bin/dgrp/config.
The dgrp_cfg_node tool has four modes of operation:

About the RealPort ID
The RealPort tools refer to an individual Digi device with an ID. You must 
choose the ID to use for each Digi device, and this ID must be unique 
within your system. The dgrp_cfg_node init operation allows you to assign 
an ID to a Digi device.
A RealPort ID consists of one or two alphanumeric characters. The 
underscore character may be used in the ID.
Once an ID is assigned, the device files in the /dev directory which are 
created by the package will encode the ID into the device name. This 
allows one, by inspection, to determine which Digi device with which a 
particular device is associated. For more information on the device naming, 
see "Create RealPort Devices" on page 70.

The Init Operation
The init operation has the following effects:

• If necessary, it will attempt to load the driver module. 

• It will determine whether a daemon is already running for the 
specified node. If it is not running, it will start the daemon. 

• It will create all necessary device files in the /dev directory. If a 
device file exists, the ownership and permissions are preserved. 

The standard usage requires a command like:

Operation Description

init operation This operation can be used to add or reinitialize a Digi device in 
Linux.

uninit operation This operation removes a Digi device from Linux.

stop operation This operation stops a RealPort daemon.

start operation This operation attempts to start a RealPort daemon.
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dgrp_cfg_node init ID IPaddr ports

The parameters are defined as follows:

For further details, see the dgrp_cfg_node man page, which is installed 
with this package.

The Uninit Operation
The uninit operation has the following effects:

• It will determine whether a daemon is running for the specified Digi 
device, and if so, will kill it. 

• It will erase all information about this Digi device from its internal 
database (this distinguishes the behavior from that of stop; please 
see below). 

The standard usage requires a command like:
dgrp_cfg_node uninit ID

The parameters are defined as follows:

Note: The command will fail if any ports are in use. Be sure to kill all applications 
using the Digi device ports before uninitialization.

Note: Even if you have removed all of the Digi devices you have previously 
registered with the driver, the dgrp_cfg_node utility will not unload the driver 
module.

For further details, see the dgrp_cfg_node man page, which is installed 
with this package.

The Stop Operation
The stop operation has the following effect:

• It will determine whether a daemon is running for the specified Digi 
device, and if so, will kill it. 

Parameter Definition

init Indicates the operation being requested

ID
Assigns the supplied ID to the Digi device. A RealPort ID consists 
of one or two alphanumeric characters. The underscore 
character may be used in the ID. 

IPaddr Either an IP address or an IP name may be assigned to the 
daemon via this parameter. 

ports

This parameter indicates the number of device files which should 
be created for this particular Digi device. This does not have to 
match the physical number of ports, but physical ports beyond 
the ports value specified will be unavailable. The maximum 
number of ports supported by the tool is 64.

Parameter Definition

uninit Indicates the operation being requested

ID Specifies which Digi device to unconfigure.
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• The RealPort software retains the information associated with this 
ID, so that the daemon can be restarted with a minimum of 
information. 

The simplest usage requires one to execute a command with a form similar 
to:

dgrp_cfg_node stop ID

The parameters are defined as follows:

One might stop a daemon in order to change the daemon's parameters, 
like the IP address (i.e. stop, then restart with new parameters). For further 
details, please see the dgrp_cfg_node man page, which is installed with 
this package.

The Start Operation
The start operation determines whether a daemon is running for the 
specified node, and if not, will attempt to execute a daemon based on the 
supplied parameters.
The simplest usage requires one to execute a command with a form similar 
to:

dgrp_cfg_node start ID IPaddr

The parameters are defined as follows:

For further details, see the dgrp_cfg_node man page, which is installed 
with this package.

Device Configuration Overview
Use these overviews of device configuration topics to decide which tool(s) 
you should use to configure your devices.

ditty-rp

Parameter Definition

stop Indicates the operation being requested

ID Specifies which Digi device's daemon to stop.

Parameter Definition

start Indicates the operation being requested

ID Specifies which Digi device's daemon to start.

IPaddr The (possibly new) IP address or IP name to use when referring to the 
Digi device with the specified ID.

Features
or
Description

Digi's device configuration program 
Run from a command prompt 
ditty-rp commands are normally included in a system startup file. 
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Configuring a Port for a:

Miscellaneous Topics

Configuring a Device for a Terminal
Use this procedure to configure a Digi serial device for a terminal. See your 
operating system documentation for more information on configuring a 
serial device for a terminal.

Procedure
1. Connect a serial cable between the port and terminal. 

2. Edit the /etc/inittab file and add a getty entry for the device. The getty 
name that configures your device can vary from system to system. The 
following examples are only meant to serve as a guide. Substitute your 
device for ttyaa011 in these examples: 

Uses

Manually configure Digi-specific device settings such as altpin or 
forcedcd 
Configure printer devices. See "Configuring a Device for a Printer" on 
page 79

Resources Refer to the man page for ditty-rp 

Terminal
See "Configuring a Device for a Terminal" on page 78.
This procedure describes how to configure a device for a terminal.

Printer
See "Configuring a Device for a Printer" on page 79.
This procedure describes how to configure a device for a printer.

Modem
See "Configuring a Device for a Modem" on page 79
This procedure describes how to configure a device for a modem.

altpin

This option should be enabled on a port when an RJ-45 8-pin cable 
is used and the Data Carrier Detect (DCD) signal is required. For 
example, altpin should be enabled on a port where an RJ-45 8-pin 
cable is used with a modem. See "About Transparent Printing" on 
page 80, and refer to the Cable Guide for your Digi product.

fastbaud

RealPort devices support baud rates in excess of the maximum 
baud rate supported by Linux. To enable the use of these fast baud 
rates, a ditty-rp parameter, fastbaud, has been provided. See the 
topic fastbaud Data Rate Mapping in "Fastbaud Data Rate 
Mapping" on page 85.

Data 
Carrier
Detect 
(DCD)

In some cases, depending on your operating system requirements 
and/or your device requirements, it may be necessary for the Data 
Carrier Detect (DCD) signal to be active on a port before it will 
function. There are two ways to fulfill this requirement.

Cabling

One way to fulfill the DCD requirement is to create a cable and 
have your device force the signal high. See the Digi One RealPort 
and PortServer Cable Guide.

ditty-rp

Another way to fulfill the DCD requirement is to enable the forcedcd 
ditty-rp option. See "About Transparent Printing" on page 80.
Chapter 7  LINUX RealPort Installation  78



Example 1: RedHat getty_ps

An example of a common RedHat terminal install script where getty is 
getty_ps would be:

dl:2345:respawn:/sbin/getty_ps ttyaa11 DT9600 vt100

Example 2: Debian agetty

An example of a common Debian terminal install script where getty is 
agetty would be:

D1:23:respawn:sbin/agetty -L ttyaa11 19200 vt100

This is an agetty example for a hard-wired terminal: 
D000:2345:respawn:/sbin/agetty -L 9600 ttya01 

Note: The "-L" flag must be used with agetty for proper functionality if DCD is not 
wired on the cable. Please exclude the "-L" flag for DCD sensitivity. 

Example 3: mgetty

An example of an mgetty modem script which is available both in RedHat 
and Debian is:

T3:23:respawn: /sbin/mgetty -x0 -s 115200 ttyaa11

Note: The mgetty command is hardcoded to use hardware flow control - which 
means 8-wire cable is a must and a 3-wire connection will not work.

3. Enable the port for login by rebooting the system or by entering this 
command at your Linux command prompt: 

init q

Configuring a Device for a Printer
You have two options in configuring your printers with Linux drivers.
1. Connect a serial cable between the port and printer. 

2. Use either the Linux printtool command to configure your printer or, set 
up the printers manually. To install a printer manually, add lines similar 
to this example to the /etc/inittab file: 

DG01:2345:once: cat < /dev/ttyaa11 > /dev/null &
dg01:2345:once: ditty-rp 38400 ctspace altpin -ixon -ixoff -

ixany /dev/ttyaa11

The device /dev/ttyaa11 is used as an example here. Substitute your particular device 
name in the previous commands. This example also sets the port speed to 38400, 
enables altpin, enables hardware flow control (ctspace and rtspace) and disables software 
flow control (-ixon, -ixoff, -ixany) on the port. Configure the ditty-rp parameters as required 
by your specific printer and cable configuration. For more information on ditty-rp, see 
"About Transparent Printing" on page 80.

Note: There is a single bit in the line control register for setting stop bits.  If this bit is 
set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

Configuring a Device for a Modem
Use this procedure to configure a Digi device for a Dial-in/Dial-out modem 
connection. Configuring a device for a modem requires familiarity with both 
the operating system and the modem being used. While the following 
procedure is sufficient for most cases, it may be necessary to take 
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additional steps to properly configure your modem or to set up the 
operating system for a specific application.

Procedure
1. Connect a serial cable between the port and modem. 

2. Power the modem on. (This example depicts hardware flow control 
configuration.)

3. At the command prompt enter: 
chown uucp:uucp /dev/ttyaa00 

where ttyaa00 is the name of the device and uucp is an UNIX application. 

4. Connect to the modem by entering this command at a command 
prompt 

cu -l /dev/ttyaa00 -s 38400

where ttyaa00 is the name of the non modem control device for the port.

5. Set the modem to answer after the first ring with this command: 
ats0=1

6. Train the modem to the port speed with this command: 
at&w

7. Enter any other desired modem commands. 

8. Terminate the connection to the modem with a tilde followed by a 
period: 

~.

9. To manually configure the port to use hardware flow control by inserting 
this command in a Linux startup file: 

ditty-rp rtspace ctspace /device

where /device is the name of the Digi device. Insert the command in a startup file so it 
remains in effect after a reboot.
Alternately, use a gettydef entry that uses hardware flow control (see the next step)

10.Edit the /etc/inittab file and add a getty entry for the device. The getty 
name that configures your device can vary from system to system. An 
example of an mgetty modem script which is available both in RedHat 
and Debian is listed below (and only meant to serve as a guide):

T3:23:respawn: /sbin/mgetty -x0 -s 115200 ttyaa00

where ttyaa00 is the name of the device.

11. Enable the port for login by rebooting the system or by entering this 
command at your Linux command prompt: 

init q

About Transparent Printing
Most terminals have an auxiliary port that can be connected to a serial 
printer. When this port is configured as a transparent printer port, print jobs 
may be run simultaneously with normal terminal operation.
Data bound for the printer is preceded by a terminal escape sequence 
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which turns on transparent printing, and followed by a sequence which 
turns transparent printing off.
Set up a transparent printer in the same way you would set up a printer 
wired directly to a serial port. Data sent to a transparent printer device is 
automatically "wrapped" in the transparent print on/off command strings for 
the specified printer.

Configuring Transparent Printers
Use this procedure to set up transparent printers on terminals. 

Note: This procedure sets up the communication characteristics for transparent 
printers. Once a transparent printer has been set up, you can use it as you 
would a printer connected directly to a serial port. See your UNIX 
documentation for information on setting up print queues.

Procedure

At the command prompt, enter:
ditty -n ttyname [options]

where ttyname is the name of the terminal device and options are selected from the list 
below.

maxcps n 
Limits the maximum printer port character-per-second data rate. n 
should be set to the minimum character rate the printer can sustain in 
typical use.

maxchar n 

Limits the number of characters queued to the printer ahead of terminal 
output. Lower numbers increase system overhead, higher numbers 
result in keystroke echo delays. A value of 50 is generally a good 
compromise at 9600 baud.

bufsize n 

This parameter should be set to a value just below the printer's buffer 
size. After a period of inactivity, the driver will burst up to this many 
characters to the printer to fill the print buffer before slowing to the 
maxcps rate.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[5i" would be entered as:
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[4i" would be entered as:
"\033[4i".

term t 

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminal types: 
adm31, ansi, dg200, dg210, hz1500, mc5, vt100, vt220, vt320, vt420, 
wang2x36, wyse30, wyse50, wyse60 or wyse75.
If the terminal type is not found in the internal default table, then ditty 
reads the terminfo entry for the terminal type and sets the transparent 
print on/off strings to the values given by the mc5/mc4 attributes found 
there.
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Setting TTY Options
The RealPort Linux device driver package includes a command, ditty-rp, 
which is a superset of stty, and may be used to set and display the device 
options for Digi RealPort devices.
The general command format is:

ditty-rp [-a] [-n ttyname] [option(s)] [ttyname]

With no options, ditty-rp displays all Digi special driver settings, modem 
signals, and all standard parameters displayed by stty(1) for the TTY 
device referenced by standard input.
Command options are provided to change flow control settings, set 
transparent print options, force modem control lines, and display all TTY 
settings. Any unrecognized options are passed to stty(1) for interpretation.
The ditty-rp commands may be executed from the command line, or placed 
in a startup script to be run whenever the system is booted.
The options are:

The following options specify transient actions to be performed 
immediately:

The following options specify actions which are not sticky, meaning that the 
changes are cancelled when the device is closed, and that the device will 

-a Display all of the unique Digi option settings, as well as all of the 
standard TTY settings reported by stty -a.

-n 
ttyname

Set and display options for the given TTY device, instead of standard 
input. This option may be specified multiple times to perform the same 
operation on multiple TTYs.

ttyname

Set and display options for the specified TTY device. Replace ttyname 
with the TTY pathname (such as /dev/ttya01s, /dev/term/a01 or /dev/dty/
a001s, depending on your operating system). This option may be used 
on a modem control line when no carrier is present.

break Send a 250 MS break signal out on the TTY line.

flush Immediately flush (discard) TTY input and output.

flushin Flush TTY input only.

flushout Flush TTY output only.
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use the default values the next time it is opened

The following options are sticky—the effects continue until the system is 
rebooted or until the options are changed.

stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.

startin Release flow control to resume stopped input.

[-]dtr Raise [drop] the DTR modem control line, unless DTR hardware flow 
control is selected.

[-]rts Raise [drop] the RTS modem control line, unless RTS hardware flow 
control is selected.

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are 
beyond the range supported by the operating system. See "Fastbaud 
Data Rate Mapping" on page 85.

[-]rtspace Enable [disable] RTS hardware input flow control, so RTS drops to 
pause remote transmission.

[-]ctspace Enable [disable] CTS hardware output flow control, so local 
transmission pauses when CTS drops.

[-]dsrpace Enable [disable] DSR hardware output flow control, so local 
transmission pauses when DSR drops.

[-]dcdpace Enable [disable] DCD hardware output flow control, so local 
transmission pauses when DCD drops.

[-]dtrpace Enable [disable] DTR hardware input flow control, so DTR drops to 
pause remote transmission.

[-]forcedcd Disable [re-enable] carrier sense, so the TTY may be opened and used 
even when carrier is not present.

startc c

Sets the XON flow control character. The character may be given as a 
decimal, octal or hexadecimal number. Octal numbers are recognized 
by the presence of a leading zero, and hexadecimal numbers are 
denoted by a leading "0x". For example, the standard XON character, 
<CTRL-Q>, can be entered as "17" (decimal), "021" (octal) or "0x11" 
(hexadecimal).

stopc c
Sets the XOFF flow control character. The character may be given as a 
decimal, octal, or hexadecimal number (see startc, above, for format of 
octal and hexadecimal numbers).

astartc c
Sets auxiliary XON flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for 
format of octal and hexadecimal numbers). 

astopc c
Sets auxiliary XOFF flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for 
format of octal and hexadecimal numbers). 

[-]aixon
Enables auxiliary flow control, so that two unique characters are used 
for XON and XOFF. If both XOFF characters are received, transmission 
will not resume until both XON characters are received.
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maxcps n

Sets the maximum Characters Per Second (CPS) rate at which 
characters are output to the transparent print device. The rate chosen 
should be just below the average print speed. If the number is too low, 
printer speed will be reduced. If the number is too high, the printer will 
resort to flow control, and user entry on the terminal will be 
correspondingly impaired. Default is 100 CPS.

maxchar n

Sets the maximum number of transparent print characters the driver 
will place in the output queue. Reducing this number increases system 
overhead; increasing this number delays operator keystroke echo 
times when the transparent printer is in use. Default is 50 characters.

bufsize n

Sets the driver’s estimate of the size of the transparent printer’s input 
buffer. After a period of inactivity, the driver bursts this many characters 
to the transparent printer before reducing to the maxcps rate selected 
above. Default is 100 characters.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: "\033[5i".

term t

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminals: 
adm31, ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, 
pcterm, tvi, vp-a2, vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, 
or wyse75. If the terminal type is not found in the internal default table, 
then ditty reads the terminfo entry for the terminal type and sets 
transparent print on/off strings to values given by the mc5/mc4 
attributes found there.
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Fastbaud Data Rate Mapping
Use the table below to see how setting fastbaud affects RealPort data 
rates. 

Troubleshooting RealPort in Linux: 

If none of the ports work:
1. Check the Status of the RealPort Daemon:

From the Linux root prompt, type: 
ps -ef | grep drpd

You should see an entry for each Digi device similar to the following, please verify the 
respective IP address.

root 2254 1 0 Dec 13 ? 0:03/usr/bin/dgrp-version/daemon/drpd a 
192.168.2.2

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit. If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

2. To restart the daemon type the following from the Linux root prompt 
using an Xterm capable session: 

 /usr/bin/dgrp-version/config/dgrp_gui

This graphical utility will allow you to highlight the desired entry, then simply select the 
Daemon Menu item from the top to be able to check, stop and start RealPort daemons.  To 
stop and start the RealPort daemons from a non graphical interface, type the following 
from the Linux root prompt:

/usr/bin/dgrp-version/config/dgrp_cfg_node –v –v stop x

This will stop the RealPort daemon, where ‘x’ represents the ID letter of the unit.  To start 
the daemon, issue the following command:

/usr/bin/dgrp-version/config/dgrp_cfg_node –v –v start x 
###.###.###.###

Again, where ‘x’ represents the unit ID letter and ###.###.###.### represents the IP 
address.

Specified Data Rate: Data Rate Mapped to:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800
85 Chapter 7   LINUX RealPort Installation 



If some of the ports do not work:
1. Check for carrier detect:

Check the serial signals by typing “display port range=[port_number]” from 
the Device root prompt.  For a graphical utility to display port signals, 
please download and install DPA Remote. Go to
http://www.digi.com/support and enter your device and Operating system 
then search DPA Remote.
If an 8 pin RJ45 cable is being used and DSR is asserted but not DCD, use 
the following command:

#>  set flow altpin=on ra=[port_number]

If DCD is not wired on the cable (using less than 8 wires) then force carrier must be 
enabled. This can be set in 

#>  set flow forcedcd=on range=[port_number]

If the OFC or IFC signals are solid, this would indicate either an output buffer overflow 
(OFC) or an input buffer overflow (IFC).  Sometimes, issuing the following command from 
the Linux root prompt can clear the port:

# ditty-rp startin startout flush ttyx##

2. If this command does not work, a reboot of the Linux server may be 
required to clear the port from an overflow condition.  Afterwards, be 
sure to match the flow control values that are configured on the 
attached device (terminal, printer, etc…).

3. Kill any active processes:

To kill any active processes, which may be stuck on the Linux host, please 
issue the following commands from the root prompt:

# fuser –k /dev/ttyx##

Where ttyx### represents the actual tty id.
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Requirements and Considerations

Read this section before beginning the RealPort driver installation.
• The Solaris RealPort device driver works with Solaris (SPARC) and 

Solaris (Intel) operating systems. For the latest versions of Solaris 
supported, see the Release Notes. 

• Installing the RealPort software on a Solaris host where RealPort 
has already been installed will overwrite the existing RealPort 
configuration on that host. 

• The Digi RealPort device driver for Solaris is an installable device 
driver; the software development system is not required to create a 
new kernel. 

• Encrypted RealPort is a security measure to maintain data integrity. 
In other words, prevent unauthorized changes in data including 
intentional destruction or alteration, tampering, duplication, or 
accidental loss. Encrypted RealPort also prevents disclosure to 
unauthorized individuals or processes. If your data is sensitive, 
Encrypted RealPort is strongly recommended. 

Information to Gather

Before you install RealPort, you need to determine:
• The hostname or IP address to assign each unconfigured Digi 

device. 

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 

• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Configuring Digi Device for RealPort

Use this procedure to configure the Digi device for use with Digi RealPort 
drivers. See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on page 
136 for configuring RealPort on a Digi CM device.

Note: See the appropriate Command Reference or Configuration and Administra-
tion Guide for information on how to perform the steps below.

Procedure
1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 

3. Verify that the RealPort TCP port number is set to 771. Change if 
necessary.
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4. For all ports that will be using RealPort, set the device type to rp. The 
following example configures ports 2 through 16 of a PortServer for 
RealPort: 

set ports range=2-16 dev=rp

Master Setup Process

1. Read any release notes that may be included with the installation 
media. 

2. Gather information necessary for installation. See Information to 
Gather, on page 88. 

3. Install the RealPort driver. See "Installing the Driver (Including 
Encrypted RealPort): CD" on page 89 or "Installing the Driver: 
Download or Integration Kit" on page 90. 

4. Configure the PortServer for RealPort. See "Configuring Digi Device for 
RealPort" on page 88 or "Master Setup Process" on page 89. 

5. Add Digi devices to the RealPort configuration with drpadmin. See 
"Adding a Digi Device with drpadmin" on page 90. 

Installing the Driver (Including Encrypted RealPort): CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.

Procedure
1. Choose an operating system. 

2. Choose the Hardware product name. 

3. Choose the software or driver you wish to install. 

4. Choose Install Software. 

5. Follow the prompts. 
Note: You will be prompted with the following to install Encrypted RealPort: 

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always

The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y
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6. Confirm your configuration.

7. Reboot your system if necessary. 

Installing the Driver: Download or Integration Kit
Use this procedure to install a downloaded Solaris device driver.

Procedure
1. Download the appropriate driver file.

2. If you have downloaded the driver file from a system other than the 
Solaris system, copy the file to the Solaris system.

3. Log onto the console as superuser (root).

4. Enter this command:
pkgadd -d path-filename

where path-filename is the path to and the name of the downloaded driver file.

5. Follow the prompts. 

Uninstalling the Driver
Use this procedure to remove the RealPort driver from your system.

Procedure
1. Delete any configured Digi devices before uninstalling the RealPort 

driver. See "Deleting a Digi Device with drpadmin" on page 91.

2. Enter the following command at a root prompt:
pkgrm realport

3. Follow the prompts.

Adding a Digi Device with drpadmin
Use this procedure to create RealPort devices and start the RealPort 
daemons.

Procedure
1. Enter this command at a root prompt: 

/usr/sbin/drpadmin

2. Answer the prompts as appropriate. 

When Prompted to: Action:

Select an option Choose add.

Enter the node name or IP 
address for this Digi device

If an IP address is used, make sure it is unique 
and does not conflict with any other network 
device.

If a name is entered, the name must be registered 
in /etc/hosts or with an accessible nameserver.

Enter the number of ports on the 
Digi device

Enter the number of ports for this Digi device. The 
installation will prompt to confirm this number.
If PORTS/Xem (EBI) modules will be attached to a 
PortServer II module, include these ports.
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Deleting a Digi Device with drpadmin
Use this procedure to delete a Digi device.

Procedure
1. Enter this command at a root prompt: 

/usr/sbin/drpadmin

2. Enter s to show all installed Digi devices. 

3. Note the number of the Digi devices to delete. 

4. Choose Enter to make the options prompt reappear. 

5. Enter d (delete). 

6. Enter the Digi device number to delete. 

7. Enter y to confirm the deletion. 

Create RealPort Devices

The RealPort installation creates four different devices for each port.
• Standard device 

• Modem device 

• Standard transparent print device 

• Modem transparent print device. 

Enter TTY device ID letter(s) Enter one or two letters. These letters will be used 
to create the RealPort device names.

Enter WAN speed if the connec-
tion between the Digi device 
and HP-UX system includes a 
WAN link slower than 1 MB

Enter the WAN speed if this is the case. Other-
wise, choose Enter to continue.

Confirm the configuration Enter y to proceed or n to reenter the information.

Select an option 
Enter a to add another Digi device. Enter s to 
show configured Digi devices. Enter q to exit 
drpadmin.
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Device Name Format

The devices are named according to the following conventions:

Here are examples of the devices created for the first port of a Digi device 
with the identification letter "a".

Standard Device
Example: /dev/dty/a001s

A standard Digi device uses an identification letter "s" in its name. The 
default handshake method is XON/XOFF. Data Carrier Detect (DCD) need 
not be present to open the device.
Once a connection is established and DCD becomes active, standard 
devices behave in the same way as modem devices--subsequent loss of 
the Data Carrier Detect signal will cause active processes on the port to be 
killed and the user will be automatically logged off.

Modem Device
Example: /dev/dty/a001m

Digi device modem devices use an identification letter "m" in their names. 
They are sometimes referred to as "dial-in" devices.
Modem devices are traditional UNIX ports with modem control. They 
require Data Carrier Detect to be high before they will operate. RTS/CTS 
handshaking is enabled by default. When used with a modem, the ports will 
wait for DCD before sending out the login prompt.
When used with a terminal or other device, it is usually wise to wire the Digi 
DCD signal to the terminal's Data Terminal Ready (DTR) line. When the 
terminal is turned on, the system outputs a login prompt. When the terminal 
is turned off, any associated jobs are killed, and the user is logged out.

a-z The Digi device letter ID. Legal letters are a-z.

001-
096 The port number on the individual Digi device.

s At the end of a device name indicates a standard device.

m At the end of a device name indicates a modem device.

Device Path/Name Example

Actual Standard Device (terminal) /dev/dty/a001s

Actual Modem Device /dev/dty/a001m

Standard Device Link (terminal) /dev/cua/a001 (linked to /dev/dty/a001s)

Modem Device Link /dev/term/a001 (linked to /dev/dty/a001m)

Standard Transparent Print Device /dev/dpr/a001s

Modem Transparent Print Device /dev/dpr/a001m
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Transparent Print Devices
Examples: /dev/dpr/a001s and /dev/dpr/a001m

The transparent print devices can be used with auxiliary printer ports on 
terminals. Output directed to a dpr device goes out the auxiliary port of a 
terminal while you continue to use the terminal normally.
Use /dev/dpr/a001s if the terminal device is /dev/dty/a001s or /dev/cua/
a001 (standard device); use /dev/dpr/a001m if the terminal device is /dev/
dty/a001m or /dev/term/a001 (modem device).

Setting Device Options with ditty

With the ditty command, display options such as flow control settings, 
speed and transparent print settings can be configured for your RealPort 
TTY devices. For detailed information on the ditty command, refer to the 
Solaris man pages and "Setting TTY Options" on page 96.

Note: To use the man pages for the first time, the path /usr/share/man must be 
added to the system MANPATH. Here is an example of such a command that 
is sufficient in most cases. At a root prompt on the system, enter:

MANPATH=$MANPATH:/usr/share/man

Note: The ditty commands should be manually inserted in the startup file /etc/rc2.d/    
S99ditty (or any other file beginning with "S99" in the same directory) so they 
are executed every time the system is booted.

Configuring a Device with admintool

The Solaris system administration utility, admintool, can be used to 
configure RealPort devices.

Note: In order to use admintool, the Digi devices need to be linked to devices in /
dev/term and /dev/cua. These links are normally created when the driver is 
installed. If these links are not there, they can be created manually.

Procedure
1. Access admintool through a window interface, or entering this com-

mand at a root prompt: 
admintool

2. From the admintool window, select Browse>Serial Ports. 

3. Select a device. 

4. Select Edit > Modify. 

5. Configure the port as needed. 

Configuring a Device for a Terminal
Use this procedure to configure a RealPort device for a terminal. See your 
Solaris documentation for more information on configuring a serial device 
for a terminal.
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding.

Procedure
1. Connect a proper cable between the port and terminal. 
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2. Invoke admintool either through the window interface, or by entering 
this command at a root prompt: 

admintool

3. Select Browse > Serial Ports. 

4. Select a device. 

5. Select Edit > Modify. 

6. Configure the device parameters. Typically a terminal device is set to 
Terminal-Hardwired and Service Enabled. 

7. Set the Baud Rate. 

Note: The default admintool baud rates cycle, meaning the speed at the end of the 
corresponding /etc/ttytype entry is different than the speed at the beginning of 
the entry. It preferable to configure a device to a fixed rate.

As an example, this line can be added to /etc/ttytype and used as a fixed rate for devices:
38400N:38400 hupcl:38400 hupcl::38400N

If a custom /etc/ttytype entry is created and used, set Baud Rate to Other and enter the /
etc/ttytype identifier (e.g. 38400N).

Note: There is a single bit in the line control register for setting stop bits.  If this bit is 
set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

Troubleshooting Tips
• If a login does not appear on the terminal, try disabling and 

reenabling the device in admintool. 

• If a cycling baud rate is used and scrambled characters appear on 
the terminal screen, hitting the Enter key several times at the 
terminal may cause the port to change baud rates and display a 
login. 

• If a cycling baud rate is used and scrambled characters appear on 
the terminal screen, change the baud rate to a fixed /etc/ttydef entry 
matching the terminal's settings. 

Configuring a Device for a Printer
Use this procedure to configure a RealPort device for a printer. See your 
Solaris documentation for more information on configuring a serial device 
for a printer.
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding.

Procedure
1. Connect a proper cable between the port and printer. 

2. Set flow control on the port to match the printer settings. 
To set hardware flow control on the port (which is more stable than software flow control), 
edit the file /etc/rc2.d/S99digi (create it if necessary) and add the following commands:

cat < /dev/dty/a001s > /dev/null &
ditty ctspace -ixon -ixoff -ixany /dev/dty/a001s

To use software flow control, edit the file /etc/rc2.d/S99digi (create the file if necessary) 
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and add the following commands:
cat < /dev/dty/a001s > /dev/null & 

ditty ixon ixoff -ixany /dev/dty/a001s 

Configuring a Device for a Modem
Use this procedure to configure a RealPort device for a Dial-in/Dial-out 
modem connection. Configuring a device for a modem requires familiarity 
with both the operating system and the modem being used. While the 
following procedure is sufficient for most cases, it may be necessary to 
take additional steps to properly configure your modem or to set up the 
operating system for a specific application.
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding.

Procedure
1. Connect a proper cable between the port and modem. 

2. Connect to the modem with tip. 
tip -38400 /dev/dty/a001s

The speed (38400) and device (/dev/dty/a001s) are used as examples in the previous tip 
command.

3. Enter one of the following commands depending on your modem:

4. Terminate the connection to the modem with a tilde-period command: 
~.

5. Access admintool by entering this command at a root prompt: 
admintool

6. Select Browse > Serial Ports. 

7. Select a device. 

8. Select Edit > Modify. 

9. Configure the device parameters. Typically a terminal device is set to 
Terminal-Hardwired and Service Enabled. 

10.Set the Baud Rate. 

Note: The default admintool baud rates cycle, meaning the speed at the end of the 
corresponding /etc/ttytype entry is different than the speed at the beginning of 
the entry. It is often preferable to set them to a fixed rate.

As an example, this line can be added to /etc/ttytype to configure the device for a 38400 
fixed rate.

38400N:38400 hupcl:38400 hupcl::38400N

If a custom /etc/ttytype entry is used, set Baud Rate to Other and enter the /etc/ttytype 
identifier (e.g. 38400N).

11. Edit the file /etc/rc2.d/S99digi (create it if necessary) and add the 
following command to it: 

Command Comment

AT&H1&B0&W Typically works for a US Robotics modem

AT&H1&W Typically works for a Hayes or other modem
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ditty rtspace ctspace /dev/dty/a001m

The device a001m is used as an example in the previous ditty command.

Setting TTY Options

RealPort UNIX device driver packages include a command, ditty, which is a 
superset of stty, and may be used to set and display the device options for 
Digi RealPort devices.
The general command format is:
ditty [-a] [-n ttyname] [option(s)] [ttyname]
With no options, ditty displays all Digi special driver settings, modem 
signals, and all standard parameters displayed by stty(1) for the TTY 
device referenced by standard input.
Command options are provided to change flow control settings, set 
transparent print options, force modem control lines, and display all TTY 
settings. Any unrecognized options are passed to stty(1) for interpretation.
ditty commands may be executed from the command line, or placed in a 
startup script to be run whenever the system is booted.
The options are:

The following options specify transient actions to be performed 
immediately:

The following options specify actions which are not sticky, meaning that the 
changes are cancelled when the device is closed, and that the device will 
use the default values the next time it is opened.

-a Display all of the unique Digi option settings, as well as all of the stan-
dard TTY settings reported by stty -a.

-n 
ttyname

Set and display options for the given TTY device, instead of standard 
input. This option may be specified multiple times to perform the same 
operation on multiple TTYs.

ttyname

Set and display options for the specified TTY device. Replace ttyname 
with the TTY pathname (such as /dev/ttya01s, /dev/term/a01 or /dev/dty/
a001s, depending on your operating system). This option may be used 
on a modem control line when no carrier is present.

break Send a 250 MS break signal out on the TTY line.

clear Clear the tbusy flag in the channel structure to free the port.

flush Immediately flush (discard) TTY input and output.

flushin Flush TTY input only.

flushout Flush TTY output only.

stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.
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The following options are sticky—the effects continue until the system is 
rebooted or until the options are changed.

startin Release flow control to resume stopped input.

[-]dtr Raise [drop] the DTR modem control line, unless DTR hardware flow 
control is selected.

[-]rts Raise [drop] the RTS modem control line, unless RTS hardware flow 
control is selected.

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are 
beyond the range supported by the operating system. See "Fastbaud 
Data Rate Mapping" on page 98.

[-]rtspace Enable [disable] RTS hardware input flow control, so RTS drops to 
pause remote transmission.

[-]ctspace Enable [disable] CTS hardware output flow control, so local transmis-
sion pauses when CTS drops.

[-]dsrpace Enable [disable] DSR hardware output flow control, so local transmis-
sion pauses when DSR drops.

[-]dcdpace Enable [disable] DCD hardware output flow control, so local transmis-
sion pauses when DCD drops.

[-]dtrpace Enable [disable] DTR hardware input flow control, so DTR drops to 
pause remote transmission.

[-]forcedcd Disable [re-enable] carrier sense, so the TTY may be opened and used 
even when carrier is not present.

startc c

Sets the XON flow control character. The character may be given as a 
decimal, octal or hexadecimal number. Octal numbers are recognized 
by the presence of a leading zero, and hexadecimal numbers are 
denoted by a leading "0x". For example, the standard XON character, 
<CTRL-Q>, can be entered as "17" (decimal), "021" (octal) or "0x11" 
(hexadecimal).

stopc c
Sets the XOFF flow control character. The character may be given as a 
decimal, octal, or hexadecimal number (see startc, above, for format of 
octal and hexadecimal numbers).

[-]aixon
Enables auxiliary flow control, so that two unique characters are used 
for XON and XOFF. If both XOFF characters are received, transmission 
will not resume until both XON characters are received.

maxcps n

Sets the maximum Characters Per Second (CPS) rate at which charac-
ters are output to the transparent print device. The rate chosen should 
be just below the average print speed. If the number is too low, printer 
speed will be reduced. If the number is too high, the printer will resort to 
flow control, and user entry on the terminal will be correspondingly 
impaired. Default is 100 CPS.

maxchar n

Sets the maximum number of transparent print characters the driver 
will place in the output queue. Reducing this number increases system 
overhead; increasing this number delays operator keystroke echo 
times when the transparent printer is in use. Default is 50 characters.

bufsize n

Sets the driver’s estimate of the size of the transparent printer’s input 
buffer. After a period of inactivity, the driver bursts this many characters 
to the transparent printer before reducing to the maxcps rate selected 
above. Default is 100 characters.
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Fastbaud Data Rate Mapping
Use the table below to see how setting fastbaud affects RealPort data 
rates. 

Transparent Printer Setup

About Transparent Printing
Most terminals have an auxiliary port that can be connected to a serial 
printer. When this port is configured as a transparent printer port, print jobs 
may be run simultaneously with normal terminal operation.
Data bound for the printer is preceded by a terminal escape sequence 
which turns on transparent printing, and followed by a sequence which 
turns transparent printing off.
Set up a transparent printer in the same way you would set up a printer 

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

term t

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminals: 
adm31, ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, 
pcterm, tvi, vp-a2, vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, 
or wyse75. If the terminal type is not found in the internal default table, 
then ditty reads the terminfo entry for the terminal type and sets trans-
parent print on/off strings to values given by the mc5/mc4 attributes 
found there.

Specified Data Rate: Data Rate Mapped to:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800
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wired directly to a serial port. Data sent to a transparent printer device is 
automatically "wrapped" in the transparent print on/off command strings for 
the specified printer.

Configuring Transparent Printers
Use this procedure to set up transparent printers on terminals. 

Note: This procedure sets up the communication characteristics for transparent 
printers. Once a transparent printer has been set up, you can use it as you 
would a printer connected directly to a serial port. See your UNIX documenta-
tion for information on setting up print queues.

Procedure

At the command prompt, enter:
ditty -n ttyname [options]

where ttyname is the name of the terminal device and options are selected from the list 
below.

maxcps n 
Limits the maximum printer port character-per-second data rate. n 
should be set to the minimum character rate the printer can sustain in 
typical use.

maxchar n 

Limits the number of characters queued to the printer ahead of terminal 
output. Lower numbers increase system overhead, higher numbers 
result in keystroke echo delays. A value of 50 is generally a good com-
promise at 9600 baud.

bufsize n 

This parameter should be set to a value just below the printer's buffer 
size. After a period of inactivity, the driver will burst up to this many 
characters to the printer to fill the print buffer before slowing to the max-
cps rate.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[5i" would be entered as:
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[4i" would be entered as:
"\033[4i".

term t 

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminal types: 
adm31, ansi, dg200, dg210, hz1500, mc5, vt100, vt220, vt320, vt420, 
wang2x36, wyse30, wyse50, wyse60 or wyse75.
If the terminal type is not found in the internal default table, then ditty 
reads the terminfo entry for the terminal type and sets the transparent 
print on/off strings to the values given by the mc5/mc4 attributes found 
there.
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Troubleshooting RealPort in Solaris: 

If none of the ports work:
1. Check the Status of the RealPort Daemon:

From the UNIX root prompt, type: 
ps -ef | grep ncxd

You should see an entry for each Digi device similar to the following, please verify the 
respective IP address.

‰‰–p 771 

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit. If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

2. To restart the daemon type the following from the UNIX root prompt: 
#  drpadmin

3. Select ‘r’ to reset, followed by the item number for the entry to reset.

If some of the ports do not work:
1. Check serial signal activity:

Check the serial signals by typing “display port range=[port_number]” from 
the Device root prompt.  For a graphical utility to display port signals, 
please download and install DPA Remote. Go to
http://www.digi.com/support and enter your device and Operating system 
then search DPA Remote.
If the OFC or IFC signals are solid, this would indicate either an output 
buffer overflow (OFC) or an input buffer overflow (IFC).  Sometimes, 
issuing the following command from the UNIX root prompt can clear the 
port:

# ditty startin startout flush /dev/dty/x###s

2. If this command does not work, a reboot of the UNIX server may be 
required to clear the port from an overflow condition.

3. Kill any active processes:

To kill any active processes, which may be stuck on the UNIX host, please 
issue the following commands from the root prompt:

# fuser –k /dev/dty/x###s

Where x###s represents the actual tty id.
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Requirements and Considerations

Read this section before beginning the RealPort driver installation.
• It is important to read any release notes that may be included with 

the installation media. 

• The RealPort device driver software for AIX is an Optional Program 
Product requiring the TCP/IP Runtime System. The presence of the 
TCP/IP Runtime System can be verified by viewing installed 
software in smit.

• Encrypted RealPort is a security measure to maintain data integrity. 
In other words, prevent unauthorized changes in data including 
intentional destruction or alteration, tampering, duplication, or 
accidental loss. Encrypted RealPort also prevents disclosure to 
unauthorized individuals or processes. If your data is sensitive, 
Encrypted RealPort is strongly recommended.  

Information to Gather

Before you install RealPort, you need to determine:
• The hostname or IP address to assign each unconfigured Digi 

device. 

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 

• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Configuring a Digi Device

Use this procedure to configure a Digi device for use with Digi RealPort 
drivers.

Note: See the appropriate Command Reference or Configuration and 
Administration Guide for information on how to perform the steps below.

Procedure
1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 

3. Verify that the RealPort TCP port number is set to 771. Change if 
necessary.

4. For all ports that will be using RealPort, set the device type to rp. The 
following example configures ports 2 through 16 of a PortServer for 
RealPort: 

set ports range=2-16 dev=rp
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Master Setup Process

Use this process to install and configure the AIX RealPort driver.
1. Read any release notes that may be included with the installation 

media. Also read "Requirements and Considerations" on page 102. 

2. Gather information necessary for installation. See "Information to 
Gather" on page 102. 

3. Install the RealPort driver. See "Installing the Driver (Including 
Encrypted RealPort): CD" on page 103 or "Installing the Driver: 
Download" on page 103. 

4. Configure the Digi device for RealPort. 

• See "Configuring a Digi Device" on page 102  

See "EtherLite RealPort Installation" on page 128 for configuring RealPort on an 
Etherlite device or "Digi CM RealPort Installation" on page 136 for configuring RealPort 
on a Digi CM device.

• "Master Setup Process" on page 103 

5. Add the Digi device with smit. See "Adding a Digi Device Using smit" on 
page 106. 

6. Configure the Digi device with smit. See "Configuring a Digi Device with 
smit" on page 106. 

7. Configure the TTY Devices as necessary. See the TTY configuration 
topics in this chapter. 

Installing the Driver (Including Encrypted RealPort): CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.

Procedure
1. Choose an operating system. 

2. Choose the Hardware product name. 

3. Choose the software or driver you wish to install. 

4. Choose Install Software. 

5. Follow the prompts. 

6. Confirm your configuration.

7. Reboot your system if necessary. 

Installing the Driver: Download 
Use this procedure to install a downloaded RealPort AIX driver with smit.
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Procedure
1. Choose Software Installation and Maintenance > Install and Update 

Software > Install/Update Selectable Software (Custom Install) > Install/
Update from All Available Software. 

2. When smit prompts you for the input device and directory for software, 
specify the path and file name and then press Enter. 

3. At the prompt "Software to install", choose all and then press Enter 
twice. 

Uninstalling RealPort
Use this procedure to uninstall the AIX RealPort driver.

Note: Before uninstalling the RealPort driver, users in most instances should 
remove the TTY devices and the Digi RealPort device. Not removing the 
devices leaves files in the system's object database.

Procedure
1. Log onto the system as superuser (root). 

2. Disable login on any RealPort TTY device with a login enabled on it. 

3. Kill any processes open on any RealPort TTY or lp device. 

4. Determine the Digi device sa device(s). At the command prompt, enter: 
smit devices 

and choose Digi Ethernet-based Serial Device.
5. Use the rmdev command to remove all the RealPort sa TTY, and lp 

devices. 
rmdev -l [sa device] -R -d 

Note: The -R option, when used to remove an sa device, will delete the sa device 
specified and all the TTY and lp devices assigned to it. This is useful if there 
are many RealPort devices to remove from the system. If you wish to remove 
individual TTY and lp devices with the rmdev command, the -R option should 
not be used.

6. Enter the command: 
smit install_remove

A dialog panel appears.

7. Alter the field SOFTWARE name to: 
digiasync.ncxa.obj

8. Alter the field PREVIEW only to: 
no

9. Choose OK. 

This prompt appears: Are You Sure?
10.Choose OK. 

The uninstallation should proceed to a successful conclusion.
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Start the RealPort Daemon

1. From the root prompt, enable all devices to available state:
# cfgmgr

2. Enable one Digi unit to available state or all devices from smit:
# mkdev -1 sa# -R

OR

# smit devices

3. Select the first menu item: “Install/Configure Devices Added After IPL”, 
press enter on the following screen with the “None” option selected 
(default).

Creating and Configuring TTYs

Use this procedure to create and configure TTY devices in AIX. The 
procedure for creating and configuring TTY devices for Digi serial ports is 
similar to the procedure used to create standard AIX TTY devices. For 
complete information, refer to your AIX documentation.

Note: The Digi device must be added (see "Adding a Digi Device Using smit" on 
page 106) either in the "Defined" or "Available" state before attempting to 
configure TTYs attached to that device.

Procedure

Repeat this procedure for each TTY device.
1. Log onto the system as super-user (root). 

2. Enter this command: 
smit mktty 

The Add a TTY menu appears.

3. Choose Add a TTY. 

A list of TTY types appears.
4. From the list, choose tty rs232 Asynchronous Terminal. 
A list of sa devices appears.

5. Choose the item that identifies the Digi device. It will be similar to:
sa3 Available Digi PortServer II 16. 

A dialog panel appears with fields to configure the port.

6. Configure the fields as necessary. The only required entry is the PORT 
number field. 

7. If the Data Carrier Detect signal is not wired between the port and the 
peripheral device attached to it, set Force Carrier to enable. 

8. Choose Enter to complete the TTY addition. The name of the TTY that 
was created will be displayed when smit command processing has 
completed. 
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Adding a Digi Device Using smit

Use this procedure to add a Digi device to an AIX system using smit.

Procedure
1. Log onto the console as super-user (root). 

2. Enter the following command: 
smit devices

3. Choose Digi Ethernet-based Serial Products > Add Digi Ethernet-based 
Serial Products. 

4. Choose the appropriate Digi device type to be added. 

5. Enter the Digi device's IP address in the IP Address field. 
An sa device will be created for the Digi device.

6. Initialize the new devices. From the Devices menu, select Install > 
Configure Devices Added After IPL. 

7. Verify that the sa device is available by entering this command at a root 
prompt: 

lsdev -Cc nts

Note: The first character of the above command is the letter, l (ell), and not the 
numeral, 1 (one).

Following is an example of the output of this command:
sa7 Available Digi PortServer 1 

An error message may display if the Digi device has not been successfully added.

Configuring a Digi Device with smit
Use this procedure to configure or reconfigure a Digi device. The AIX 
RealPort software should be installed before using this procedure.

Procedure
1. Enter the following command at a root prompt on the AIX console: 

smit devices

2. Choose Digi device. 

3. Configure the Digi device as necessary. Follow the smit prompts. 
Note: You will be prompted with the following to install Encrypted RealPort: 

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always

The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y
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4. Change / Show Characteristics of the Digi device. Below is an example 
of configuration information. 

Digi PortServer sa7 +

Type cts_16 +

Description Digi PortServer 16 +

IP Address [ip address]

STATUS of Device at Config Time up +

Server Port Number [771]

WAN Link Speed [ ] 

Setting TTY Device Options with stty-ncxa and chdev

With the stty-ncxa command, display attributes such as flow control 
settings, speed and transparent print settings can be configured for your 
Digi TTY devices. The stty-ncxa program is placed into the directory
 /usr/lbin/tty [ /usr/1bin/tty/stty-ncxa] when RealPort is installed. 
This directory is not commonly set as a PATH variable. This means that the 
entire path has to be entered when using the command, or the directory 
has to be added to the PATH variable so the command can be entered 
without the path.
For information about stty-ncxa, see "Setting TTY Options" on page 111.

Note: Many of the same attributes that can be configured with stty-ncxa can be 
configured with smit. See "Configuring a Digi Device with smit" on page 106.

The stty-ncxa command configures device attributes until the system is 
rebooted. Use a chdev command to permanently set device attributes.

chdev -l [tty#/lp#] -a [attribute]=[value]

where:

Configuring a TTY Device for a Terminal
Use this procedure to configure a RealPort device for a terminal. See your 
operating system documentation for more information on configuring a 
serial device for a terminal.

Procedure
1. Connect a proper cable between the port and terminal. See the 

appropriate cable guide (listed in the table of contents) for more 
information. 

2. At an AIX root prompt, enter this command: 

[tty#/lp#] is the name of the device to change.

[attribute]

is the attribute or option to set. This can be any stty-ncxa option. ‘Term’ 
is such an option.
The "ditty/stty-ncxa" "term" value does NOT correlate in any way with 
the environmental variable called TERM. (SMIT and "chdev" are both 
modifying the environmental variable TERM, and not the ditty "term" 
value). They are 2 distinct and different values.

[value] is the value assigned to the attribute.
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smit tty

3. Choose Change/Show Characteristics of a TTY. 

4. Select a TTY device. Here's an example of a listed device: 
tty7 Available 00-00-04-02 Asynchronous Terminal

In this example, the first 00 is the bus number. This is unused and will always be 00. The 
second 00 is the slot number. This is unused and will always be 00. The number 04 is the 
sa device number. The number 02 is the port number.

5. Set Enable LOGIN to enable. 

6. Set BAUD rate to match the terminal's baud rate. 

7. Set PARITY, BITS per character, and Number of STOP BITS to match 
the terminal's settings. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

8. Set TERMINAL type to match the type of terminal on the port. This is 
important if you will be using transparent printing on the auxiliary port of 
the terminal. 

9. Set FLOW CONTROL to match the flow control used by the terminal 

10. If DCD is not physically wired high in your cable, set Force Carrier to 
enable. 

Configuring a TTY Device for a Printer
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding. This procedure assumes that a tty has been 
created for the printer. See "Creating and Configuring TTYs" on page 105.

Procedure
1. Connect a proper cable between the port and printer. See the 

appropriate Cable Guide in the online table of contents. 

2. At the server, enter this command at a root prompt: 
smit printer

3. Choose Printer/Plotter Device > Add a Printer/Plotter > osp Other serial 
printer > rs232. 

4. Choose an sa device. 

5. Enter a port number in the PORT number field. 

6. Set BAUD rate, PARITY, BITS per character, and number of STOP 
BITS to match the settings of the printer. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.
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7. Set FLOW CONTROL to be used to match the flow control used by the 
printer. 

8. If the Data Carrier Detect signal is not wired between the port and the 
peripheral device attached to it, set Force Carrier to enable. 

9. Choose Enter to complete the TTY addition. 

Configuring a TTY Device for a Modem
Use this procedure to configure a RealPort device for a Dial-in/Dial-out 
modem connection. Configuring a device for a modem requires familiarity 
with both the operating system and the modem being used. While the 
following procedure is sufficient for most cases, it may be necessary to 
take additional steps to properly configure your modem or to set up the 
operating system for a specific application.
The Digi device and RealPort should be properly installed, configured and 
functioning before proceeding. This procedure assumes that a tty has been 
created for the modem. See "Creating and Configuring TTYs" on page 105.

Procedure
1. Turn the modem on. 

2. Access a root prompt on the AIX system. 

3. Add an entry for the device in the file /usr/lib/uucp/Devices. The 
following example allows a connection of 9600 baud to the device: 

Direct tty3 - 9600 direct

4. Use the following command to connect to the modem: 
cu -ml ttyX

In this command, ttyX is the device name for the port.

The modem should respond with an AT prompt.
5. Train the modem to the port speed by entering this command at the AT 

prompt: 
at&w

6. Terminate the connection by entering: 

~. (a tilde followed by a period)

7. Choose Enter at the AT prompt.

8. At an AIX root prompt, enter this command: 
smit tty

9. Choose Change/Show Characteristics of a TTY. 

10.Choose a TTY device. This is an example of a listed device: 
tty7 Available 00-00-04-02 Asynchronous Terminal

In this example, the first 00 is the bus number. This is unused and will always be 00. The 
second 00 is the slot number. This is unused and will always be 00. The number 04 is the 
sa device number. The number 02 is the port number.

11. Set Enable LOGIN to share. 
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12.Set BAUD rate to the modem's highest configurable baud rate. 

13.Set PARITY, BITS per character, and number of STOP BITS to match 
the settings of the modem. 
Note: There is a single bit in the line control register for setting stop bits.  If this bit is 

set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

14.Set FLOW CONTROL to be used to match the flow control used by the 
modem. 

  Transparent Printer Setup

About Transparent Printing
Most terminals have an auxiliary port that can be connected to a serial 
printer. When this port is configured as a transparent printer port, print jobs 
may be run simultaneously with normal terminal operation.
Data bound for the printer is preceded by a terminal escape sequence 
which turns on transparent printing, and followed by a sequence which 
turns transparent printing off.
Set up a transparent printer in the same way you would set up a printer 
wired directly to a serial port. Data sent to a transparent printer device is 
automatically "wrapped" in the transparent print on/off command strings for 
the specified printer.

Configuring Transparent Printers
This procedure sets up the communication characteristics for transparent 
printers. Once a transparent printer has been set up, you can use it as you 
would a printer connected directly to a serial port. See your UNIX 
documentation for information on setting up print queues.

Procedure

At the command prompt, enter:
/usr/1bin/tty/stty-ncxa -n ttyname [options]

where ttyname is the name of the terminal device and options are selected from the list 
below..

maxcps n 
Limits the maximum printer port character-per-second data rate. n 
should be set to the minimum character rate the printer can sustain in 
typical use.

maxchar n 

Limits the number of characters queued to the printer ahead of terminal 
output. Lower numbers increase system overhead, higher numbers 
result in keystroke echo delays. A value of 50 is generally a good com-
promise at 9600 baud.

bufsize n 

This parameter should be set to a value just below the printer's buffer 
size. After a period of inactivity, the driver will burst up to this many 
characters to the printer to fill the print buffer before slowing to the max-
cps rate.
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Configuring Transparent Printers: Examples

Use the stty-ncxa program to set up your terminal for transparent printing.

Example 1:

The following command configures the transparent print options for a DEC 
VT100 terminal connected to /dev/tty1 (note that the printer will be called /
dev/lp1). maxcps, maxchar and bufsize are left to defaults. Enter:

/usr/1bin/tty/stty-ncxa term vt100 /dev/tty1

Note: The "ditty/stty-ncxa" "term" value does NOT correlate in any way with the 
environmental variable called TERM. (SMIT and "chdev" are both modifying 
the environmental variable TERM, and not the ditty "term" value). They are 2 
distinct and different values

Example 2:

The following example uses onstr and offstr arguments (this sets the 
terminal to use the ANSI Standard). Again maxcps, maxchar, and bufsize 
are defaults. Enter (on a single command line):

/usr/1bin/tty/stty-ncxa onstr \033[5i offstr \033[4i /dev/tty1

Example 3:

This example command sets the transparent print option for a WYSE30 
terminal, with a maxcps of 75, a maxchar of 100, and a printer buffer size, 
bufsize, of 1000. Enter (on a single command line):

/usr/1bin/tty/stty-ncxa term wyse30 maxcps 75 maxchar 100 
bufsize 1000 /dev/tty1

  Setting TTY Options

RealPort UNIX device driver packages include a command, stty-ncxa, 
which is a superset of stty, and may be used to set and display the device 

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[5i" would be entered as: "\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer.
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence "<Esc>[4i" would be entered as: "\033[4i".

term t 

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminal types: 
adm31, ansi, dg200, dg210, hz1500, mc5, vt100, vt220, vt320, vt420, 
wang2x36, wyse30, wyse50, wyse60 or wyse75.
If the terminal type is not found in the internal default table, then ditty 
reads the terminfo entry for the terminal type and sets the transparent 
print on/off strings to the values given by the mc5/mc4 attributes found 
there.
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options for Digi RealPort devices.
The general command format is:
/usr/1bin/tty/stty-ncxa [-a] [-n ttyname] [option(s)] [ttyname]
With no options, stty-ncxa displays all Digi special driver settings, modem 
signals, and all standard parameters displayed by stty(1) for the TTY 
device referenced by standard input.
Command options are provided to change flow control settings, set 
transparent print options, force modem control lines, and display all TTY 
settings. Any unrecognized options are passed to stty(1) for interpretation.
stty-ncxa commands may be executed from the command line, or placed in 
a startup script to be run whenever the system is booted.
The options are:

The following options specify transient actions to be performed 
immediately:

The following options specify actions which are not sticky, meaning that the 
changes are cancelled when the device is closed, and that the device will 
use the default values the next time it is opened.

The following options are sticky—the effects continue until the system is 

-a Display all of the unique Digi option settings, as well as all of the stan-
dard TTY settings reported by stty -a.

-n 
ttyname

Set and display options for the given TTY device, instead of standard 
input. This option may be specified multiple times to perform the same 
operation on multiple TTYs.

ttyname

Set and display options for the specified TTY device. Replace ttyname 
with the TTY pathname (such as /dev/ttya01s, /dev/term/a01 or /dev/dty/
a001s, depending on your operating system). This option may be used 
on a modem control line when no carrier is present.

• break • Send a 250 MS break signal out on the TTY line.

• flush • Immediately flush (discard) TTY input and output.

• flushin • Flush TTY input only.

• flushout • Flush TTY output only.

stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.

startin Release flow control to resume stopped input.

[-]dtr Raise [drop] the DTR modem control line, unless DTR hardware flow 
control is selected.

[-]rts Raise [drop] the RTS modem control line, unless RTS hardware flow 
control is selected.
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rebooted or until the options are changed.

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are 
beyond the range supported by the operating system. See "Fastbaud 
Data Rate Mapping" on page 114.

[-]rtspace Enable [disable] RTS hardware input flow control, so RTS drops to 
pause remote transmission.

[-]ctspace Enable [disable] CTS hardware output flow control, so local transmis-
sion pauses when CTS drops.

[-]dsrpace Enable [disable] DSR hardware output flow control, so local transmis-
sion pauses when DSR drops.

[-]dcdpace Enable [disable] DCD hardware output flow control, so local transmis-
sion pauses when DCD drops.

[-]dtrpace Enable [disable] DTR hardware input flow control, so DTR drops to 
pause remote transmission.

[-]forcedcd Disable [re-enable] carrier sense, so the TTY may be opened and used 
even when carrier is not present.

startc c

Sets the XON flow control character. The character may be given as a 
decimal, octal or hexadecimal number. Octal numbers are recognized 
by the presence of a leading zero, and hexadecimal numbers are 
denoted by a leading "0x". For example, the standard XON character, 
<CTRL-Q>, can be entered as "17" (decimal), "021" (octal) or "0x11" 
(hexadecimal).

stopc c
Sets the XOFF flow control character. The character may be given as a 
decimal, octal, or hexadecimal number (see startc, above, for format of 
octal and hexadecimal numbers).

astartc c
Sets auxiliary XON flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for for-
mat of octal and hexadecimal numbers). 

astopc c
Sets auxiliary XOFF flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for for-
mat of octal and hexadecimal numbers). 

[-]aixon
Enables auxiliary flow control, so that two unique characters are used 
for XON and XOFF. If both XOFF characters are received, transmission 
will not resume until both XON characters are received.

maxcps n

Sets the maximum Characters Per Second (CPS) rate at which charac-
ters are output to the transparent print device. The rate chosen should 
be just below the average print speed. If the number is too low, printer 
speed will be reduced. If the number is too high, the printer will resort to 
flow control, and user entry on the terminal will be correspondingly 
impaired. Default is 100 CPS.

maxchar n

Sets the maximum number of transparent print characters the driver 
will place in the output queue. Reducing this number increases system 
overhead; increasing this number delays operator keystroke echo 
times when the transparent printer is in use. Default is 50 characters.

bufsize n

Sets the driver’s estimate of the size of the transparent printer’s input 
buffer. After a period of inactivity, the driver bursts this many characters 
to the transparent printer before reducing to the maxcps rate selected 
above. Default is 100 characters.
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Fastbaud Data Rate Mapping
Use the table below to see how setting fastbaud affects RealPort data 
rates. 

Troubleshooting RealPort in AIX: 

If none of the ports work -
1. Verify AIX RealPort sa Device is Pointing to the Correct Unit:

From AIX, type: 
smit dev  Digi Ethernet Devices  Change show  sa##

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: "\033[5i".

term t

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminals: 
adm31, ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, 
pcterm, tvi, vp-a2, vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, 
or wyse75. If the terminal type is not found in the internal default table, 
then ditty reads the terminfo entry for the terminal type and sets trans-
parent print on/off strings to values given by the mc5/mc4 attributes 
found there.

Specified Data Rate: Data Rate Mapped to:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800
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2. Check the Status of the RealPort Daemon:

From AIX, type: 
ps -ef | grep ncxd

Note the time that the daemon started. Check again several minutes later. If the time has 
changed then the daemon attempted to connect to the PORTSERVER, failed and tried 
again. 
3. To restart the daemon type: 

kill –9 [PID_of_ncxd_process]

The daemon will respawn from the inittab entry.  Any tty and lp devices should become 
available. The print queue or login process may need to be restarted. 

If some of the ports do not work -
1. Check for carrier detect:

All tty and lp devices in AIX require DCD in order to respond.  If DCD is not 
asserted check to see if the device plugged into the port is powered on and 
online. Check the serial signals by typing 

display port range=[port_number] 

from the Device root prompt.

If an 8 pin RJ45 cable is being used and DSR is asserted but not DCD, use the following 
command:

#>  set flow altpin=on ra=[port_number]

If DCD is not wired on the cable (using less than 8 wires) then force carrier must be 
enabled. This can be set in 

#>  set flow forcedcd=on range=[port_number]

If the OFC or IFC signals are solid, this would indicate either an output buffer overflow 
(OFC) or an input buffer overflow (IFC).  Sometimes, issuing the following command from 
the AIX root prompt can clear the port:

# /usr/lbin/tty/stty-ncxa startin startout flush tty#

2. If this command does not work, a reboot of the AIX server may be 
required to clear the port from an overflow condition.

3. Kill any active processes:

To kill any active processes which may be stuck on the AIX host, please 
issue the following commands from the AIX root prompt: 

# fuser –k /dev/tty#

Where tty# represents the actual tty id.
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Requirements and Considerations
Read this section before beginning the RealPort driver installation.

• Check the release notes for HP-UX RealPort driver support 
versions. 

• Encrypted RealPort is a security measure to maintain data integrity. 
In other words, prevent unauthorized changes in data including 
intentional destruction or alteration, tampering, duplication, or 
accidental loss. Encrypted RealPort also prevents disclosure to 
unauthorized individuals or processes. If your data is sensitive, 
Encrypted RealPort is strongly recommended. 

• Once the RealPort driver is installed, HP-UX manual pages are 
available for: 

Information to Gather
Before you install RealPort, you need to determine:

• The hostname or IP address to assign each unconfigured Digi 
device. 

• The number of ports for each Digi device. Include any PORTS/em 
Modules that are attached to the Digi device. 

• Determine the link speed between the host machine and the Digi 
device if a slow WAN link (for example, a 56K leased line) connects 
them. 

Configuring the Digi Device for RealPort
Use this procedure to configure the Digi device for use with Digi RealPort 
drivers. See "EtherLite RealPort Installation" on page 128 for configuring 
RealPort on an Etherlite device or "Digi CM RealPort Installation" on page 
136 for configuring RealPort on a Digi CM device.

Note: See the appropriate Command Reference or Configuration and 
Administration Guide for information on how to perform the steps below.

Procedure
1. Access a root prompt on the Digi device. 

2. Set the Digi device’s IP address. 

Chapter 10 H P - U X  R e a l P o r t  I n s t a l l a t i o n

Item Function

ditty Sets and displays RealPort device TTY options

drpadmin The Digi RealPort configuration utility

drpd The Digi RealPort network driver

drp The Digi RealPort driver
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3. Verify that the RealPort TCP port number is set to 771. Change if 
necessary.

4. For all ports that will be using RealPort, set the device type to rp. The 
following example configures ports 2 through 16 of a PortServer for 
RealPort: 

set ports range=2-16 dev=rp

Master Setup Process
Use this process to install and configure the HP-UX RealPort driver.
1. Read any release notes that may be included with the installation 

media. 

2. Gather information necessary for installation. See "Information to 
Gather" on page 116. 

3. Install the RealPort driver. See "Installing the Driver (Including 
Encrypted RealPort): CD" on page 117 or"Installing a Driver: Download" 
on page 118. 

4. Create RealPort devices. See "Add, Configure, or Delete a Digi Device 
with drpadmin" on page 119. 

5. Configure the TTY Devices as necessary. See the TTY configuration 
topics beginning on page 121. 

Installing the Driver (Including Encrypted RealPort): CD
When installing from CD, the install commands may have been scripted for 
you.  Using the CD front-end program, navigate to the RealPort installation 
and click install; A terminal window will be launched where you can view 
install messages and respond to prompts.  You may also choose to install 
the driver manually from CD -- copy the driver files from the CD to a 
location on your local hard disk (like /tmp) and run the commands given 
below for downloaded drivers.

Procedure
1. Choose an operating system. 

2. Choose the Hardware product name. 

3. Choose the software or driver you wish to install. 

4. Choose Install Software. 

5. Follow the prompts. 
Note: You will be prompted with the following to install Encrypted RealPort: 

Would you like this RealPort session to be encrypted?

NOTE: Not all RealPort products support encrypted RealPort 
sessions.

Please check your RealPort product's firmware release notes

or product literature before selecting "always".

If in doubt, select "never".

(always/never) : (never): always
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The following device will be configured,

0       10.1.3.68       16      aa      secure (always)

Is this correct (y to add or x to abort) ? y

6. Confirm your configuration.

7. Reboot your system if necessary. 

Installing a Driver: Download
Use this procedure to install the HP-UX RealPort device driver after 
downloading it.

Note: This is an example of an installation of RealPort on HP-UX. Your installation 
steps may vary depending on your version of HP-UX. Consult your HP-UX 
documentation for information on installing drivers.

Procedure
1. Log onto the console as root. 

2. Copy the driver file to /tmp either from a diskette, or by using ftp. 

3. Extract the files from the compressed tar file with this command: 
tar xvf filename.tar

where filename.tar is the name of the downloaded tar file.

4. Now register the installation package with the system by entering the 
following command: 

swreg -l depot /tmp/drp.pkg

5. Once the component files have been copied, use the swinstall program 
to copy the component files to the system. 

/usr/sbin/swinstall -s /tmp/drp.pkg

6. Choose the DRP line item. 

7. Choose Actions > Mark for Install. 

8. Choose Actions > Install (analysis)... 

The Install Analysis window appears.
9. Choose OK to proceed. 

10.Confirm the prompts that follow. 
Upon successful completion, swinstall will reboot your system.

11. Continue with the procedure "Add, Configure, or Delete a Digi Device 
with drpadmin" on page 119. 

Uninstalling RealPort
Use this procedure to remove a Digi device from HP-UX.

Procedure
1. Delete any configured Digi devices on the HP-UX system. See 

"Deleting a Digi Device with drpadmin" on page 119.

2. Enter this command at a Unix root prompt: 
Chapter 10  HP-UX RealPort Installation  118



swremove

The SD - Remove Software Selection window appears.

3. Choose DRP (Digi RealPort Driver). 

4. Choose Actions > Remove (Analysis)... 

5. Choose OK to continue at the Remove Analysis window. 

6. Choose Yes at the Confirmation windows that appear. 

7. Choose Done at the Remove window. 

8. Confirm the prompt to reboot the system when it appears. If it does not 
appear, the system should be rebooted manually. 

9. After the system reboots, remove any remaining driver files by entering 
the command: 

rm -r /tmp/drp.pkg 

Add, Configure, or Delete a Digi Device with drpadmin
Use this procedure to create RealPort devices and start the RealPort 
daemons.

Procedure
1. Enter this command at a root prompt: 

/usr/sbin/drpadmin

2. Answer the prompts as appropriate. 

Deleting a Digi Device with drpadmin
Use this procedure to delete a Digi device.

When Prompted to: Action:

Select an option Choose add.

Enter the node name or IP 
address for this Digi device

If an IP address is used, make sure it is unique and 
does not conflict with any other network device.
If a name is entered, the name must be registered in /
etc/hosts or with an accessible nameserver.

Enter the number of ports 
on the Digi device

Enter the number of ports for this Digi device. The 
installation will prompt to confirm this number.
If PORTS/Xem (EBI) modules will be attached to a 
PortServer II module, include these ports.

Enter TTY device ID 
letter(s) 

Enter one or two letters. These letters will be used to 
create the RealPort device names.

Enter WAN speed if the 
connection between the 
Digi device and HP-UX 
system includes a WAN link 
slower than 1 MB

Enter the WAN speed if this is the case. Otherwise, 
choose Enter to continue.

Confirm the configuration Enter y to proceed or n to reenter the information.

Select an option Enter a to add another Digi device. Enter s to show 
configured Digi devices. Enter q to exit drpadmin.
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Procedure
1. Enter this command at a root prompt: 

/usr/sbin/drpadmin

2. Enter s to show all installed Digi devices. 

3. Note the number of the Digi devices to delete. 

4. Choose Enter to make the options prompt reappear. 

5. Enter d (delete). 

6. Enter the Digi device number to delete. 

7. Enter y to confirm the deletion. 

Create RealPort Devices
The RealPort installation creates three different devices for each port in the 
/dev directory.

• Standard device 

• Modem device 

• Transparent print device 

Device Name Format

The devices are named according to the following conventions:

Following are examples of the devices for the first port of a PortServer with 
the identification letters "aa":

Standard Device
Example: /dev/cuaa01

A standard Digi device begins with the prefix "cu". The default handshake 
method is XON/XOFF. Data Carrier Detect (DCD) need not be present to 
open the device.
Once a connection is established and DCD becomes active, standard 
devices behave in the same way as modem devices. Subsequent loss of 
the Data Carrier Detect signal will cause active processes on the port to be 
killed and the user will be automatically logged off.

• aa-zz • The Digi device letter ID.

• 01-64 • The port number on the individual Digi device.

Device Path Name Example

• Standard Device • /dev/cuaa01

• Modem Device • /dev/ttyaa01

• Standard Transparent Print 
Device

• /dev/praa01
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Modem Device
Example: /dev/ttyaa01

Digi modem devices begin with the prefix "tty". They are sometimes 
referred to as "dial-in" devices.
Modem devices are traditional UNIX ports with modem control. They 
require Data Carrier Detect to be high before they will operate. RTS/CTS 
handshaking is enabled by default. When used with a modem, the ports will 
wait for DCD before sending out the login prompt
When used with a terminal or other device, it is usually wise to wire the Digi 
DCD signal to the terminal's Data Terminal Ready (DTR) line. When the 
terminal is turned on, the system outputs a login prompt. When the terminal 
is turned off, any associated jobs are killed, and the user is logged out.

Transparent Print Device
Example: /dev/praa01

The transparent print device can be used with auxiliary printer ports on 
terminals. Output directed to a "pr" device goes out the auxiliary port of a 
terminal while you continue to use the terminal normally.

Configuring a Device for a Terminal
Use this procedure to configure a RealPort device for a terminal. See your 
operating system documentation for more information on configuring a 
serial device for a terminal.

Procedure
1. In HP-UX, TTY devices require the carrier detect high. This must either 

be tied high within the cable or it can be forced high in the driver by 
entering a ditty command, like the following example, for the port in a 
startup file: 

ditty forcedcd ttya12

2. Connect a proper cable between the port and terminal. 

3. Enable the port by editing the /etc/inittab file. Locate the proper 
RealPort device to enable and change the word off to respawn. This 
line shows an example of a inittab entry for the first port of a PortServer 
with a designation letter of "a". 

Xx01:23:off:/etc/getty ttya12 H

4. Change the letter or number at the end of the entry as needed. The last 
number or letter (H in the previous example) is an entry in the /etc/
gettydefs file. This sets the speed, data bits, stop bit(s) and parity for the 
port. Consult your operating system documentation for more 
information on /etc/gettydefs. 

5. Enter the following command at a root prompt: 
init q

Configuring a Device for a Printer
Use this procedure to configure a RealPort device for a printer. See your 
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operating system documentation for more information on configuring a 
serial device for a printer.

Procedure
1. In HP-UX, TTY devices require Data Carrier Detect to be high. This 

must either be tied high within the cable, or it can be forced high in the 
driver by entering this ditty command for the port in a startup file: 

ditty forcedcd ttya12

The device, ttya01, is used as an example in this command.

2. Connect a proper cable between the port and printer. 

Configuring a Device for a Modem
Use this procedure to configure a RealPort device for a Dial-in/Dial-out 
modem connection. Configuring a device for a modem requires familiarity 
with both the operating system and the modem being used. While the 
following procedure is sufficient for most cases, it may be necessary to 
take additional steps to properly configure your modem or to set up the 
operating system for a specific application.

Procedure
1. Connect a proper cable between the port and modem. 

2. On the HP-UX server, use vi to enable the new modem entries in the /
etc/inittab file for dial-in. Here are examples of two entries for Digi 
RealPort ports:

Xx01:23:off:/etc/getty ttya12 H
Xx02:23:off:/etc/getty ttyb02 H 

3. Change the word off to respawn for each port you want enabled. For 
example:

Xx01:23:respawn:/etc/getty ttya12 H
Xx02:23:respawn:/etc/getty ttyb02 H

Note: The numbers associated with each "tty" represent port number (ttya01 is Port 
1, ttya08 is Port 8). 

The last number or letter (H in the previous example) is an index into the /etc/gettydefs 
file, which may be set to any of the allowable baud rates (check your operating system's 
manual.). In this case, H specifies 9600 baud, 8 data bits, 1 stop bit, and no parity. 

Note: There is a single bit in the line control register for setting stop bits.  If this bit is 
set with 6, 7, or 8 data bits it gives 2 stop bits, but with 5 data bits it actually 
gives 1.5 stop bits.The driver and firmware simply set this line control register 
bit if 2 stop bits are requested--so with 5 data bits you actually get 1.5 stop 
bits, not 2.

4. Enter the following command at a root prompt:
init q 

5. Modify the file /usr/lib/uucp/Devices. Add an entry for the device at the 
end of the file like this:

Direct cua12 - 38400 direct 

6. Comment out any ACU lines relating to this device until dialin is working 
properly. 
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Note: An ACU line is necessary for correct operation of the modem in dialout 
applications. Refer to your modem manual or to the modem manufacturer for 
the correct initialization string to use for your modem. Refer to your operating 
system documentation for guidance on setting up an appropriate ACU entry 
that uses this initialization string. 

7. Connect to the modem by entering this command at a root prompt:
cu -l /dev/cua12 -s 38400

at&w [train modem to port speed]

Note: In HP-UX, the TTY device name is for dial-in, the cu name is for dial-out. 

8. To exit cu, enter: 

~. (a tilde followed by a period) 

Setting TTY Options
RealPort UNIX device driver packages include a command, ditty, which is a 
superset of stty, and may be used to set and display the device options for 
Digi RealPort devices.
The general command format is:
ditty [-a] [-n ttyname] [option(s)] [ttyname]
With no options, ditty displays all Digi special driver settings, modem 
signals, and all standard parameters displayed by stty(1) for the TTY 
device referenced by standard input.
Command options are provided to change flow control settings, set 
transparent print options, force modem control lines, and display all TTY 
settings. Any unrecognized options are passed to stty(1) for interpretation.
ditty commands may be executed from the command line, or placed in a 
startup script to be run whenever the system is booted.
The options are:

The following options specify transient actions to be performed 

• -a • Display all of the unique Digi option settings, as well as all of the stan-
dard TTY settings reported by stty -a.

• -n 
ttynam
e

• Set and display options for the given TTY device, instead of standard 
input. This option may be specified multiple times to perform the 
same operation on multiple TTYs.

• ttyname • Set and display options for the specified TTY device. Replace 
ttyname with the TTY pathname (such as /dev/ttya01s, /dev/term/a01 
or /dev/dty/a001s, depending on your operating system). This option 
may be used on a modem control line when no carrier is present.
123 Chapter 10   HP-UX RealPort Installation 



immediately:

The following options specify actions which are not sticky, meaning that the 
changes are cancelled when the device is closed, and that the device will 
use the default values the next time it is opened.

The following options are sticky—the effects continue until the system is 
rebooted or until the options are changed.

break Send a 250 MS break signal out on the TTY line.

flush Immediately flush (discard) TTY input and output.

flushin Flush TTY input only.

flushout Flush TTY output only.

stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.

startin Release flow control to resume stopped input.

[-]dtr Raise [drop] the DTR modem control line, unless DTR hardware flow 
control is selected.

[-]rts Raise [drop] the RTS modem control line, unless RTS hardware flow 
control is selected.

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are 
beyond the range supported by the operating system. See "Fastbaud 
Data Rate Mapping" on page 125.

[-]rtspace Enable [disable] RTS hardware input flow control, so RTS drops to 
pause remote transmission.

[-]ctspace Enable [disable] CTS hardware output flow control, so local 
transmission pauses when CTS drops.

[-]dsrpace Enable [disable] DSR hardware output flow control, so local 
transmission pauses when DSR drops.

[-]dcdpace Enable [disable] DCD hardware output flow control, so local 
transmission pauses when DCD drops.

[-]dtrpace Enable [disable] DTR hardware input flow control, so DTR drops to 
pause remote transmission.

[-]forcedcd Disable [re-enable] carrier sense, so the TTY may be opened and used 
even when carrier is not present.

startc c

Sets the XON flow control character. The character may be given as a 
decimal, octal or hexadecimal number. Octal numbers are recognized 
by the presence of a leading zero, and hexadecimal numbers are 
denoted by a leading "0x". For example, the standard XON character, 
<CTRL-Q>, can be entered as "17" (decimal), "021" (octal) or "0x11" 
(hexadecimal).
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Fastbaud Data Rate Mapping
Use the table below to see how setting fastbaud affects RealPort data 
rates. 

stopc c
Sets the XOFF flow control character. The character may be given as a 
decimal, octal, or hexadecimal number (see startc, above, for format of 
octal and hexadecimal numbers).

astartc c
Sets auxiliary XON flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for 
format of octal and hexadecimal numbers). 

astopc c
Sets auxiliary XOFF flow control character. The character may be given 
as a decimal, octal, or hexadecimal number (see startc, above, for 
format of octal and hexadecimal numbers). 

[-]aixon
Enables auxiliary flow control, so that two unique characters are used 
for XON and XOFF. If both XOFF characters are received, transmission 
will not resume until both XON characters are received.

maxcps n

Sets the maximum Characters Per Second (CPS) rate at which 
characters are output to the transparent print device. The rate chosen 
should be just below the average print speed. If the number is too low, 
printer speed will be reduced. If the number is too high, the printer will 
resort to flow control, and user entry on the terminal will be 
correspondingly impaired. Default is 100 CPS.

maxchar n

Sets the maximum number of transparent print characters the driver 
will place in the output queue. Reducing this number increases system 
overhead; increasing this number delays operator keystroke echo 
times when the transparent printer is in use. Default is 50 characters.

bufsize n

Sets the driver’s estimate of the size of the transparent printer’s input 
buffer. After a period of inactivity, the driver bursts this many characters 
to the transparent printer before reducing to the maxcps rate selected 
above. Default is 100 characters.

onstr "s"

Defines the terminal escape sequence to direct subsequent data to the 
transparent printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: 
"\033[5i".

offstr "s"

Defines the terminal escape sequence to stop directing data to the 
printer. 
s is a string of ASCII characters, enclosed in quotes, that command the 
terminal to enter transparent printing mode. An arbitrary octal character 
xxx may be given as \xxx.
For example, the sequence <Esc>[5i would be entered as: "\033[5i".

term t

Sets the transparent printer on/off strings to values found in the internal 
default table. Internal defaults are used for the following terminals: 
adm31, ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, 
pcterm, tvi, vp-a2, vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, 
or wyse75. If the terminal type is not found in the internal default table, 
then ditty reads the terminfo entry for the terminal type and sets 
transparent print on/off strings to values given by the mc5/mc4 
attributes found there.

Specified Data Rate: Data Rate Mapped to:
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Troubleshooting RealPort in HP-UX: 

If none of the ports work -
1. Check the Status of the RealPort Daemon:

From the HP-UX root prompt, type: 
ps -ef | grep drpd

You should see an entry for each Digi device similar to the following, please verify the 
respective IP address.

root 2254 1 0 Dec 13 ? 0:03/sbin/drpd 1 199.86.5.1

There are entries for IP address and node name. Use only one or the other, not both. 
Make sure that it is the correct IP address or node name for the particular unit. If using the 
node name, make sure that the host can ping or telnet to that node name. (ping 
nodename) 

2. To restart the daemon type the following from the UNIX root prompt: 
/sbin/init.d/drp.daemon start

If some of the ports do not work:
1. Check for carrier detect:

All blocking/modem control devices in HP-UX require DCD in order to 
respond.  If DCD is not asserted check to see if the device plugged into the 
port is powered on and online. Check the serial signals by typing “display 
port range=[port_number]” from the Device root prompt.  For a graphical 
utility to display port signals, please download and install DPA Remote. Go 
to http://www.digi.com/support and enter your device and Operating 
system then search DPA Remote.
If an 8 pin RJ45 cable is being used and DSR is asserted but not DCD, use 
the following command:

 set flow altpin=on ra=[port_number]

If DCD is not wired on the cable (using less than 8 wires) then force carrier must be 
enabled. This can be set in 

set flow forcedcd=on range=[port_number]

If the OFC or IFC signals are solid, this would indicate either an output buffer overflow 
(OFC) or an input buffer overflow (IFC).  Sometimes, issuing the following command from 
the HP-UX root prompt can clear the port:

50 57600

75 76800

110 115200

134 131657

150 153600

200 230400

300 460800
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 ditty startin startout flush ttyx##

2. If this command does not work, a reboot of the HP-UX server may be 
required to clear the port from an overflow condition.

3. Kill any active processes:

To kill any active processes which may be stuck on the HP-UX host, please 
issue the following commands from the root prompt:

fuser –k /dev/ttyx##

Where ttyx### represents the actual tty id.
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Configuring Etherlite for Windows Server 2003/2000/XP
To configure Etherlite for RealPort, you must configure an IP address for 
the device. Use dgipserv from the CD or from the Digi Technical Support 
site http://www.digi.com/support/. 

Upgrading Etherlite Firmware
Use this procedure to upgrade the firmware on a Digi RealPort EtherLite 
module.

Procedure
1. Download the latest firmware upgrade, the DgIPserv utility, and the 

Verlog utility from the Digi website at http://www.digi.com/support. 

2. Create and name a folder and extract the compressed files to the folder.

3. Execute the DgIPserv utility. 

4. Choose Update Firmware > Next > and browse to the location of the 
extracted firmware files.

5. Choose the appropriate *.bin file 
where * represents the EtherLite firmware part number. 

6. Follow the prompts by entering the EtherLite's MAC address and it's 
current IP settings.

7. Recycle the power, allowing 10 seconds before reseating the power, 
and choose Finish. The message “Transfer complete!” will appear 
confirming a successful upgrade to the firmware. You do not need to 
reboot your system.

Note: To verify the firmware update, use the Digi Verlog utility. It will list the EtherLite 
model, the new firmware version, and other related information. 

Removing the Driver from an EtherLite System
Use this procedure to remove RealPort from your system.

Procedure
1. Right-click My Computer > choose Properties > Hardware. 

2. Choose Device Manager > select Digi EtherLite > right-click > select 
Uninstall. 

Configuring Etherlite for Windows NT
To configure Etherlite for RealPort, you must configure an IP address for 
the device. The recommend way to do this is during Windows NT RealPort 
driver installation. 

Upgrading Etherlite Firmware
Use this procedure to upgrade the firmware on a Digi RealPort EtherLite 
module.
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Procedure
1. Download the latest firmware upgrade from the Digi website at

 http://www.digi.com/support.

2. Create and name a folder, for example ELupgrade, and extract the 
compressed firmware upgrade files to the folder.

3. Locate and execute the DgIPserv utility. The utility was installed with the 
RealPort driver and can be found in the default directory location at 
c:\WINNT\system32.

4. Choose Update Firmware > Next and browse to the location of the 
extracted firmware files.

5. Change the Files of type from EtherLite Firmware *.prm to EtherLite 
Firmware *.bin and choose the appropriate *.bin file where * 
represents the EtherLite firmware part number.

6. Follow the prompts by entering the EtherLite's MAC address and its 
current IP settings.

7. Recycle the power and choose Finish. A message will appear 
confirming a successful upgrade to the firmware. 

8. Reboot your system. 
Note: To verify the firmware update, use the Digi Verlog.exe utility found on the Digi 

website. It will list the EtherLite model, its firmware version, and related 
information. 

Removing the Driver
Use this procedure to remove RealPort from your system.

Procedure
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose Digi RealPort Driver and then Remove.

3. Follow the prompts to complete removal.

Configuring Etherlite for Windows 9x/Me
To configure Etherlite for RealPort, you must configure an IP address for 
the device. The recommend way to do this is during Windows 9x/Me 
RealPort driver installation. This method is described in the following 
discussions:

• "Installing the Driver: CD" on page 27

• "Upgrade RealPort on Microsoft Windows 98 or Microsoft Windows 
Me" on page 28 

Upgrading Etherlite Firmware
Use this procedure to upgrade the firmware on a Digi RealPort EtherLite 
module.

Procedure
1. Download the latest firmware upgrade from the Digi website at

 http://www.digi.com/support.
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2. Create and name a folder, for example ELupgrade, and extract the 
compressed firmware upgrade files to the folder.

3. Locate and execute the DgIPserv utility. The utility was installed with the 
RealPort driver and can be found in the default directory location at 
c:\WIN9x\system32.

4. Choose Update Firmware > Next and browse to the location of the 
extracted firmware files.

5. Change the Files of type from EtherLite Firmware *.prm to EtherLite 
Firmware *.bin and choose the appropriate *.bin file where * 
represents the EtherLite firmware part number.

6. Follow the prompts by entering the EtherLite's MAC address and it's 
current IP settings.

7. Recycle the power and choose Finish. A message will appear 
confirming a successful upgrade to the firmware. 

8. Reboot your system. 
Note: To verify the firmware update, use the Digi Verlog.exe utility found on the Digi 

website. It will list the EtherLite model, its firmware version, and related 
information. 

Removing the Driver
1. From the Start menu, choose Settings > Control Panel > Network > 

Services.

2. Choose Digi RealPort Driver and then Remove.

3. Follow the prompts to complete removal.

Configuring EtherLite for SCO OpenServer
Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 

Procedure
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic). 

Assigning an IP Address
EtherLite IP addresses may be set by either of two methods:

• dgipserv, a UNIX utility for setting EtherLite IP addresses (see 
below)

• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address
The dgipserv Digi utility is used to set the IP addresses for Digi devices. It 
will also set the gateway and subnet mask addresses when needed to 
upgrade the Digi device's firmware. For more information on dgipserv, 
consult the man pages.
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Procedure
1. Enter the command: 

dgipserv 

2. Enter the following command to store an IP address in your Digi device: 
dgipserv -store MAC_address(IP_address) 

where the MAC address and the IP address are the addresses of the Digi device as in the 
following example. 

dgipserv -store 10:e0:f7:15:20:8g 192.168.2.2 

For additional configurations for EtherLite, refer to the "Uninstalling RealPort" on page 37 
or "Deleting a Digi Device with drpadmin" on page 42.

Configuring EtherLite for SCO UNIXWare
Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic).

Assigning an IP Address
EtherLite IP addresses may be set by either of two methods:
• dgipserv, a UNIX utility for setting EtherLite IP addresses (see below)
• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address
The dgipserv utility configures the IP address, subnet mask, and gateway . 
For more information on dgipserv consult the man pages.

Note: dgipserv works with firmware version 7.9 or later.
1. Enter the command: 

dgipserv 

2. To store an IP addresses in your Digi device enter: 
dgipserv -store MAC_address(IP_address) 

where the MAC_ address and the IP address are the addresses of the Digi device. An 
example of this command is: 

dgipserv -store 10:e0:f7:15:20:8g 192.168.2.2 

Configuring EtherLite for LINUX
Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 

Procedure
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic). 

Assigning an IP Address

EtherLite IP addresses may be set by either of two methods:
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• dgipserv, a UNIX utility for setting EtherLite IP addresses (see 
below)

• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address

The dgipserv utility is used to set the IP addresses for Digi devices. It will 
also set the gateway and subnet mask addresses when needed to upgrade 
the Digi device's firmware. For more information on dgipserv consult the 
man pages.

Procedure
1. Enter the command: 

dgipserv 

2. To store an IP addresses in your Digi device enter: 
dgipserv -store MAC_address(IP_address) 

where the MAC address and the IP address are the addresses of the Digi device. An 
example of this command is: 

dgipserv -store 10:e0:f7:15:20:8g 192.168.2.2 

For additional configuration of EtherLite products see "Master Setup Process" on page 63 
and follow the procedures listed.

Configuring EtherLite for Solaris

Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 

Procedure
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic). 

Assigning an IP Address
EtherLite IP addresses may be set by either of two methods:

• dgipserv, a UNIX utility for setting EtherLite IP addresses (see 
below)

• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address
The dgipserv utility is used to set the IP addresses for Digi devices. It will 
also set the gateway and subnet mask addresses when needed to upgrade 
the Digi device's firmware. For more information on dgipserv consult the 
man pages.

Procedure
1. Enter the command: 

dgipserv 

2. To store an IP addresses in your Digi device enter: 
Chapter 11  EtherLite RealPort Installation  132



dgipserv -store MAC_address(IP_address) 

where the MAC address and the IP address are the addresses of the Digi device. An 
example of this command is: 

dgipserv -store 10:e0:f7:15:20:8g 143.182.5.63 

For additional configuration see "Master Setup Process" on page 89 and 
follow the procedure listed.

Configuring EtherLite for AIX
Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 

Procedure
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic). 

Assigning an IP Address
EtherLite IP addresses may be set by either of two methods:

• dgipserv, a UNIX utility for setting EtherLite IP addresses (see 
below)

• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address
The dgipserv utility is used to set the IP addresses for Digi devices. It will 
also set the gateway and subnet mask addresses when needed to upgrade 
the Digi device's firmware. For more information on dgipserv consult the 
man pages.

Procedure
1. Enter the command: 

dgipserv 

2. To store an IP addresses in your Digi device enter: 
dgipserv -store MAC_address(IP_address) 

where the MAC address and the IP address are the addresses of the Digi device. An 
example of this command is: 

dgipserv -store 10:e0:f7:15:20:8g 143.182.5.63 

For additional configuration see "Master Setup Process" on page 103 and follow the 
procedure listed.

Configuring EtherLite for HP-UX
Use this procedure to install and configure an EtherLite device for use with 
Digi RealPort drivers. 

Procedure
1. Attach the EtherLite module to the network using an appropriate cable. 

2. Assign an IP address to the EtherLite module (see the following topic). 
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Assigning an IP Address
EtherLite IP addresses may be set by either of two methods:

• dgipserv, a UNIX utility for setting EtherLite IP addresses (see 
below)

• EtherLite Boot Console (see the EtherLite Administration Card)

Using dgipserv to Assign an IP Address
The dgipserv utility is used to set the IP addresses for Digi devices. It will 
also set the gateway and subnet mask addresses when needed to upgrade 
the Digi device's firmware. For more information on dgipserv consult the 
man pages.

Procedure
1. Enter the command: 

dgipserv 

2. To store an IP addresses in your Digi device enter: 
dgipserv -store MAC_address(IP_address) 

where the MAC address and the IP address are the addresses of the Digi device. An 
example of this command is: 

dgipserv -store 10:e0:f7:15:20:8g 192.168.2.2 

For additional configuration see "Master Setup Process" on page 117 and follow the 
procedure listed.
Chapter 11  EtherLite RealPort Installation  134



135 Chapter 11   EtherLite RealPort Installation 



RealPort Support

RealPort software provides a virtual connection to serial devices, no matter 
where they reside on the network. The software is installed directly on the 
host and allows applications to talk to devices across a network as though 
the devices were directly attached to the host. In actuality, the devices are 
connected to a Digi device server or terminal server somewhere on the 
network. 
RealPort is unique among COM port re-directors because it is the only 
implementation that allows multiple connections to multiple ports over a 
single TCP/IP connection. Other implementations require a separate TCP/
IP connection for each serial port. Unique features also include full 
hardware and software flow control, as well as tunable latency and 
throughput.

Note: RealPort does not support authentication and user rights are not validated.

Requirements
The Digi CM unit requires a web browser to enable RealPort. The unit must 
have IP assigned. (See the Digi CM User’s Guide for more information). 
When you use RealPort (configured on a per port basis) device server 
functionality is unavailable. That is to say that device server can be used 
for console management or for COM re-direction but not both. An example 
of RealPort use would be remote kernal debugging of Microsoft Windows 
Servers. To enable RealPort use the following procedure. 

Enabling RealPort
1. Enter the IP address in the URL address bar on the web browser.

2. Log in (username root; password dbps).

3. To enable RealPort click Serial port > Configuration > Port number.

4. Select Enable this port from the drop down menu.

5. Select Enable RealPort support from the drop down menu.

6. Click Save to flash and continue with other configurations or click Save & 
apply. 

Chapter 12 D i g i  C M  R e a l P o r t  I n s t a l l a t i o n
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Troubleshooting Overview
There are several resources available to you for support of your Digi 
product or resolving configuration difficulties. Try these troubleshooting 
steps to eliminate your problem. After working through these steps and 
your problem is not solved, try the resources listed below. 

1. Visit our Support knowledge bases at http://www.digi.com/support/
knowledgebase.jsp to look for articles related to your situation. 

2. Visit our Support Forums at http://www.digi.com/support/forum/ and 
search for possible posts from other users with similar situations. 

3. If the knowledge base or support forums do not have the information 
you need, fill out an Online Support Request via http://www.digi.com/
support/eservice/eservicelogin.jsp. Creation of a new user account will 
be required. 

4. You may also email our support staff at support.wizards@digi.com. 

Digi Network Device Does Not Power On:
Reset the Digi device back to factory defaults and try again. All of the 
devices have a reset button. You will need to power cycle the Digi device 
while holding in the reset button. Continue holding in the reset button for 
about 60 seconds and then release. The device should now be set back to 
Factory Defaults. Since it generally takes a few minutes for the unit to 
reset, you may want to wait before attempting access to the Digi device. If 
there is any LED activity, check to see if it is flashing a code sequence 
shown in the table below.

Chapter 13 T r o u b l e s h o o t i n g

Digi One IA Reset button PortServer TS 8 Reset Button
(Hold button down until LEDs flash
5-1-1 pattern)
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Power and LED Activity: 
Always check the power first.  Use the following chart to interpret the 
LEDS:

Network Communication Verification:
Note: Not applicable for EtherLite or Digi CM devices.

If you are unable to communicate with the Digi unit over the network, try the 
following:
1.  Make sure you are not behind a firewall or running any third party 

firewall software on your PC.

2.  Make sure Internet Connection Firewall is not enabled in Windows XP/
2003. Make sure Internet Explorer isn’t using proxy server and this has 
been disabled.

3. Ping the IP address:
ping ###.###.###.###

Where ###.###.###.### represents the actual IP address assigned to the unit.  

If you do not receive ping responses, please confirm the network settings 
on the unit match up with your network environment by logging in directly to 
one of the serial ports.   This can be done by connecting a PC (with 
terminal emulation software such as Hyperterminal), or by attaching a 
dumb terminal.  A crossover (null modem) cable will be necessary.  Set the 
dip switches to EIA-232 communication for the port you will login to:  1-up; 
2, 3, & 4-down.  

Configure your terminal or emulation software for the following 
communication settings: 
       • VT-100 emulation

LED Activity Indication
1-1-1 Starting the EOS

9-1-1 Corrupt EOS

1-5-1 Configuration has been returned to the factory 
default settings

Steady Blinking Seeking an IP Address from DHCP Server

Solid Boot Completed Successfully
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       • 9600 baud
       • 8-bit characters
       • 1 stop bit
       • No parity
You may need to press [Enter] to see the login prompt.  Login as root and 
issue the “set config” command to view current network settings.  If you 
are applying a static IP address, make sure dhcp is set to off.  Apply any 
other network settings needed in your environment such as, domain, 
gateway and nameserver information.  A reboot may be required.   After 
these settings are confirmed, try to ping from the Digi device root prompt 
(#>) to another network node and vice versa to see if the unit is now 
communicating on the network.

Note: Also verify the Ethernet cable is plugged in securely and is pinned 
appropriately.

The Link (LI) LED on the Digi device will indicate if the network is being 
detected.
4. If the unit responds to pings, next try to telnet to the unit:

telnet ###.###.###.###

You should see the login prompt from the unit.  If not, power off the Digi unit and try the 
ping command again.  This will rule out a possible duplicate IP address being assigned to 
the unit.

Note: Make sure in Windows Operating Systems that Internet Sharing Services is 
not turned on or you will be able to ping the unit, but not have Telnet access to 
the Digi device.

Serial Port Problems

Make sure that the port server is configured correctly
Note: Not applicable for EtherLite or Digi CM devices.

1. Review the port settings: 
#>  set port ra=* 

Any port that is going to have a RealPort device attached, should have: 
dev  - Needs to be set to rp or prn.
auto – Needs to be set to off  

Note: You can use the Web Interface to verify the device type as well.

Any port that is going to have a RealPort device attached, should have all 
signals off except ixon and ixoff (which can be on or off) and altpin (which 
should be off for a 10 wire cable and on for anything else). 

Note: You can use the Web Interface to verify the port setting as well.

#>  set auth

Will show settings like the following: 

Realport should show "o" for all RealPort ports.  The ports are indicated 

Ind IPaddr Mask RealPort Login Unrestricted

1 0.0.0.0 0.0.0.0 oooo-ooo -------- oooooooo
o-oooooo -------- oooooooo
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across in groups of eight -- In the example above, all ports are set correctly 
in the RealPort column except ports 5 and 10 (which are possibly being 
used for non-RealPort connections as indicated by the “-” in position 5 and 
10). This can only be verified in the command line.

Check for stuck processes:
Note: Not applicable for EtherLite or Digi CM devices.

1. At the root command prompt type:
#>  who

If a process (RealPort or otherwise) is running on the port, type:
#>  kill tty=[port_number] 

If this does not work, unplug the serial device and reboot the Digi device. 

Check the LEDs on the port to see if OFC is on this can be monitored using 
our DPA Remote software available for download our website. Go to
http://www.digi.com/support and enter your device and Operating system 
then search DPA Remote.
2. If still not working, try typing control-Q from a terminal (or PC running 

terminal emulation software) attached to the port.  Otherwise the port 
will need to be flushed from the operating system level.

Make sure that the RealPort host can reach the Digi Device:
Note: Not applicable for EtherLite or Digi CM devices.

Once the who command (see above) shows no processes on the port, from 
the UNIX RealPort host root prompt, type:

telnet [IP_of_digi_unit] 771

From a Windows PC go to Start > Run and enter the above command.
If the host cannot telnet to the 771 socket then RealPort won't connect to it. 
This would indicate that the IP address or the RealPort (771) socket is in 
use, being blocked or fire walled.  If the connection succeeds, you can 
disconnect using <Ctrl> ] <Enter>, followed by typing quit at the telnet 
prompt.
If you are unable to communicate with the individual ports on the Digi 
device, first confirm the port dip switches are configured to match your 
peripheral devices communication protocol for RS-232 (1-up; 2, 3, & 4-
down), RS-485 or RS-422.

Conducting a Loopback Test (All UNIX and Microsoft Windows Operating Systems):
Note: Not applicable for EtherLite or Digi CM devices.

1. Plug the RJ-45 loopback plug into the serial port to be tested. 

2. From the command prompt (or Start > Run in Windows), telnet to the      
IP address of the Digi device using the following command from your 
UNIX prompt: 
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     telnet ###.###.###.###

Replacing ###.###.###.### with the actual IP address of the unit.

3.  Login as root (default password of dbps).

From the Digi device root prompt:
#>  set line baud=(baud_rate)  range=(port_number)

#>  set port dev=prn auto=off range=(port_number)

To configure testing at 9600 baud:
#>  set line baud=9600  range=(port_number)

4.   Kill any residual processes on the port:
#>  kill tty=(port_number)

5.      Connect directly to the port:
#>  connect (port_number)

You will connect directly to the port and see any incoming data from any device attached 
to the port.   By inserting the loopback plug shipped with the Digi product into the 
appropriate port, you will be able to view any data typed on your “connect” session.  
Removing the loopback plug will not display data typed on the “connect” session.   If the 
loopback test worked, you have successfully tested the integrity of the port.

6.        Close the connect session:
<Ctrl> [ .    <Enter>

Type <ctrl> [  followed by a period and the Enter key to close the connect session.

Loopback plug pin-out information:
http://www.digi.com/support

Trouble Accessing Port:
Verify that there are no processes currently running on the port from the 
Digi device root prompt:

#>  who

If there appear to be process on the port, the following command will kill 
non-RealPort processes.  If the “Connected To” field shows RealPort, this 
will need to be killed at the Operating System level of the RealPort server/
host (see your operating system documentation for information about 
killing a process).  

#>  kill tty=#

Note: Rebooting the unit can also clear the process.

Cabling:
If the loopback test performed in the previous sections passed, but you are 
unable to communicate to your device, you will need to verify:
You are using the proper cabling: 
http://www.digi.com/support

Note: Altpin settings: When altpin is enabled, DCD becomes available on pin 1 of an 
8-pin RJ-45 connector  (set flow altpin=on range=(port_number).

If you have not resolved your problem at this point, please write down how 
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far you were able to get in the above procedures (and the results) to 
describe your problem. 
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Digi Contact Information
Digi International
11001 Bren Road East
Minnetonka, MN 55343
U.S.A.

Digi Contacts
World Wide Web: www.digi.com

email digi.info@digi.com

Telephone (U.S.) 1-952-912-3444

Telephone (other locations) +1 (952) 912-3444
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